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Introduction

This document contains information important to localization vendors who translate
existing Silicon Graphics documentation into different languages. Most of the
information in this document can be found in other Silicon Graphics manuals that
describe how to create a documentation. Where appropriate, this guide points the vendor
to those locations for further information.

Although this book’s primary focus is online documentation, some hard copy issues will
be discussed as well. Hard-copy production is occasionally required for a translated
document; some procedures that are irrelevant for online books must be followed in
order to accommodate these situations.

This document includes the following chapters:

• Chapter 1, “Overview,” provides an overview of the book building process used to
produce localized books for Silicon Graphics as well as specific notes that may be
useful to you.

• Chapter 2, “Bookbuild Tools,” describes how to install bookbuild tools and set up a
workarea for bookbuilding.

• Chapter 3, “Using FrameMaker Files and IPTemplate Features,” describes how to
apply templates that implement the Silicon Graphics document structure.

• Chapter 4, “External Cross References and Multiple Link Targets,” describes how to
create and test external book links and how to find and fix multiple link targets.

• Chapter 5, “Building Online Books,” describes how to prepare source files for the
online version of a manual. It also explains how to view an online book that was
created using the bookbuild process.

• Chapter 6, “Debugging Bookbuild Errors,” describes how to debug bookbuild
errors.

• Chapter 7, “Testing Online Books,” describes how to test online books.

• Chapter 8, “Testing Help Books,” describes how to test help books.

• Chapter 9, “Preparing Files for Handoff to Silicon Graphics,” provides instructions
on how to prepare files for the first, second, and final handoffs to Silicon Graphics.
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• Chapter 10, “Transferring Files Using FTP,” provides instructions on how to use FTP
to transfer files.

• Chapter 11, “Reporting Bugs,” provides instructions on how to report bugs found in
books.

• Appendix A, “Rules to Follow When Using the Templates,” is a quick reference list
of rules to follow when using the IPTemplates.

• Appendix B, “Building and Testing HTML Books,”provides instructions on how to
build, install, and test HTML books.

Please call your Silicon Graphics contact if you have questions or need additional
information on the procedures described in this book. Any errors, omissions,
clarifications and requests for enhancements can be directed to prodtech@sgi.com.

Conventions Used in This Guide

These type conventions and symbols are used in this guide:

Helvetica Bold Hardware labels

Italics Command monitor commands, filenames, IRIX commands,
manual/book titles, onscreen button names, program variables, tools,
utilities, variable command-line arguments, and variables to be
supplied by the user in examples

nnn (Lowercase italic ns) Placeholders for the version number in the part
number: 007-1234-nnn.

Fixed-width type

Error messages, prompts, and onscreen text

Bold fixed-width type

User input, including keyboard keys (printing and nonprinting); literals
supplied by the user in examples

> (Right angle bracket) Cascading menu(s); indicates a path of menu,
submenu, and menu item

# IRIX shell prompt for the superuser (root)

% IRIX shell prompt for users other than superuser
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Chapter 1

1. Overview

This chapter provides an overview of the process required to produce localized books for
Silicon Graphics as well as specific notes that may be useful to you. The following topics
are discussed:

• “Roles of Localization and Technical Publications Production” on page 1

• “Project Milestones” on page 2

• “Schedule” on page 3

• “Vendor Kits” on page 5

• “Project Files” on page 6

• “IRIS InSight Professional Publisher Templates” on page 8

• “Online and Printed Documents” on page 9

• “Document and Directory Part Numbers” on page 11

• “Standard Silicon Graphics Bookshelves” on page 13

• “Reference Materials” on page 16

Roles of Localization and Technical Publications Production

Silicon Graphics’ Localization Department (L10N) oversees the language translation of
IRIX operating systems, software, and books. As the project manager for localizing
books, L10N determines the books to be translated, qualifies and hires the localization
vendors, details the project schedule, provides linguistic review at various stages of the
project, and authorizes the payment of your bills.

Technical Publications Production provides production personnel to prepare files,
complete localization specs, provide technical support, perform quality assurance and
help testing, generate test reports, file bug reports, and build final images for
manufacturing release.
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Project Milestones

In general, all book localization projects include the same series of tasks and follow a
schedule based on dependencies.

Table 1-1 shows a typical localization project’s milestones, the expected duration to
complete the task, and the milestone(s) that must be completed before the task can begin.

Table 1-1 Book Localization Milestones, Duration, and Dependencies

Milestone ID Task Days Dependency ID

1 L10N selects vendors and obtains nondisclosure
agreement so tools may be provided

0

2 L10N defines the list of books to be translated 0

3 L10N and Production sends the vendor kit (including
build tools) and the first set of diff files to the vendor(s)

1- 3 1

4 L10N receive a cost estimate (quote) from the vendor(s) 3 3

5 L10N establishes an initial project schedule (Schedule 1) 1 4

6 Vendor begins the translation 1 5

7 English document freeze occurs 3

8 L10N defines milestones 3 7

9 English manufacturing release (MR) occurs 0

10 Production sends the vendor(s) the final diff files (if
required)

1 - 3 7

11 L10N receives the final quote from the vendor(s) 2 10

12 L10N determines the final list of books (if needed) 2 7

13 Vendor begins the document update based on the new
diff files (if necessary)

5 10

14 L10N provides the final project schedule 2 9, 11

15 Vendor provides the first hand-off of project files 1 13, 6

16 Production and the subsidiaries review the vendor’s first
hand-off and provide feedback

5 15



Schedule

3

Schedule

The schedule for a typical localization project, including the project’s milestones and
dependencies, is shown in Figure 1-1.

17 Vendor incorporates feedback and provides a second
hand-off of project files

5 16

18 Production and the subsidiaries review the vendor’s
second hand-off

5 17

19 Subsidiary review is completed 0 18

20 Vendor incorporates second hand-off (final) changes and
provides final hand-off

5 18, 19

21 Production completes final quality assurance testing and
checks in files

15 20

22 Vendor incorporates final changes (if necessary) 2 21

23 L10N creates CD images 1 21, 22

24 Production and L10n test CD images 2 23

25 L10N releases the CD to manufacturing 1 24

26 First customer ship date occurs 10 25

Table 1-1 (continued) Book Localization Milestones, Duration, and Dependencies

Milestone ID Task Days Dependency ID
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Figure 1-1 Localization Project Schedule with Dependencies

Vendor selection
List of books defined
Kit + 1st Diff & bld tools to vendor

Quote (estimate) from vendor

Schedule 1fleshed out

Translation begins

English doc freeze

L10N Milestone defined

Final Diff to vendor

Book list update (if needed)

Final quote from vendor

Doc update begins

Review 1 - TechPubs + Subs
Vendor incorporate feedback

Review 2 - TechPubs + Subs

Subsidiary review complete

Vendor incorporate review 2 changes

Final Prod QA done - Vendor final fixes

CD final images done

L10N MR

FCS

Month 1 Month 4Month 2 Month 3

English MR

Final schedule fleshed out
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Vendor Kits

Before the project starts, you will be given some hardware and the software tools you
need to meet your deliverables requirement.

Localization’s Kit

The L10N vendor kit includes

• Style guide

• Dictionary

• ftp instructions (or see Chapter 10, “Transferring Files Using FTP”)

Production’s Kit

Technical Publications Production will supply the following:

• Silicon Graphics’ WorldView Books Production Guide

• IRIS InSight Professional Publisher Templates (also known as IPTemplates)

• Book building tools and instructions for installation

– make

– insight_dev

– prod_toolroot

– impr_rip

– impr_kanji (Japanese only)

• Scripts and instructions for their use

– gethelp (see “Helpmaps” on page 115)

– installtestbooks (“Installing a Localized Book for Testing” on page 109)

• Silicon Graphics system (if necessary)
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Project Files

Silicon Graphics will supply all the files you need to produce the English version of a
book. These files and their naming conventions are discussed in these sections:

• “Localization Specification” on page 6

• “Word Count Text File” on page 6

• “Document Files” on page 7

Localization Specification

You will receive a localization specification for each book undergoing localization. The
localization specification provides a list of the files that are being supplied to you and
describes the deliverables expected from you.

Word Count Text File

Word count text files are ASCII text files containing all word count information for a new
English book. If a book is being revised, the word count file will also show the differences
in word counts from a prior English revision that was later localized to the current
English revision.

The naming convention is YY.MM.DD.00X-XXXX-nnn.wc.txt for books undergoing
localization for the first time and YY.MM.DD.00X-XXXX-nnX_nnY, where 00X_00Y are
the two revisions that have been compared to one another.

Example 1-1 shows a typical wc.txt file.
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Example 1-1 Word Count Text File

Document Files

The files you download from Silicon Graphics should be all that you need to produce an
English version of a document. These files include

*.doc FrameMaker source files for the book

bookfile FrameMaker bookfile

*.sgm SGML files for the online version of the book

Makefile Text file with instructions

orig directory All the original artwork for the book

• .rgb files are RGB screen captures.

• .ai files are Encapsulated PostScript files authored in
Adobe Illustrator.

• .ps files are Encapsulated PostScript files authored in
Adobe Illustrator.

• .mv files are Silicon Graphics movie format files.

print directory The print versions of the artwork for the book

• .bw files are the grayscale versions of the .rgb files after they have
been put through the tobw tool.

online directory All .gif files for the online version of the book

007-1342-090

007-1342-070

File Names Total word count Inserted Deleted

*.doc 3442 1343 275

Totals 3442 1343 275

Total diffs =
inserted + deleted

1618
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help directory All the helpmaps necessary for the book to act as online help for an
application or utility

diff directory All the compare (CMP) and summary (SUM) files documenting the
differences between this version and a previous version of the book.

IRIS InSight Professional Publisher Templates

Silicon Graphics uses single-source documentation for all its technical manuals. All
content is input into FrameMaker which is considered the documentation “source.”

A set of custom-designed FrameMaker templates, known as IPTemplates, are used for all
Silicon Graphics books. Each template has its own set of character and paragraph
catalogs and cross-reference formats. These paragraph and character tags and
cross-reference formats must be used in order for the mif-to-sgm translations to work
correctly. The translator and build tools include a set of styles that determine how the
tags and cross-references will appear in a hard copy or online book. A more detailed
description of the templates can be found in Chapter 3, “Using FrameMaker Files and
IPTemplate Features.”

All English source files provided to you have been authored using the IPTemplate or
have had the IPTemplate applied to them. It is unlikely that you would need to apply an
IPTemplate to any documents before you translate them, but if tags or formats are
inadvertently changed, a complete set of IPTempates are included with your Vendor Kit.
See “Applying the Templates to Existing Files” in the IRIS InSight Professional Publisher
Templates for instructions on how to apply a template.

Note: Do not create “custom” tags or change the cross-reference formats. This could
cause errors during the bookbuild process. Silicon Graphics will not accept documents
with errors.
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Online and Printed Documents

From the FrameMaker source, the documentation can take two different paths
simultaneously. These paths are discussed in the following sections:

• “FrameMaker-to-Online Documents” on page 9

• “FrameMaker File to Printed Document” on page 10

FrameMaker-to-Online Documents

This is a very general overview of what happens during the conversion to online. This
process starts with a FrameMaker .doc file that is saved out as a Frame Maker Interchange
Format (MIF) file. An ASCII text file, the .mif file can be easily parsed by an application or
script. From the mif file, a translator converts the mif into a standard generalized marker
language (SGML) file. The sgml files are merged into one DynaText book. DynaText files
can be viewed using a DynaText viewer. Figure 1-2 shows the process that is used for
converting FrameMaker docs into an online book. Note that this process is automated
with tools provided to you.

Figure 1-2 Document File Process: FrameMaker File to DynaText Book

file.doc

file.mif

file.sgm

Inso tools

IRIS InSight 
(DynaText) book
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Viewing an Online Book in IRIS InSight and on the Web

To add functionality, Silicon Graphics puts a wrapper around the DynaText viewer and
calls it IRIS InSight. IRIS InSight provides capabilities such as cross-book linking;
launchable universal resource locators (URLs), reference (man) pages, glossary definitions,
and applications; and complete internal-book cross-referencing.

Silicon Graphics uses a Web utility from Inso Providence that automatically converts
DynaText books into hypertext marker language (HTML) on the fly. This comes at a loss of
functionality normally found in IRIS InSight. Silicon Graphics does nothing special to
make the books show up on the Web. If you have a Silicon Graphics system with
DynaWeb enabled, it views the same source that IRIS InSight views on the same system.

FrameMaker File to Printed Document

Using the same FrameMaker document used in Figure 1-2, PostScript files are made and
sent to a print vendor to be printed.

Before you generate the PostScript files,

• Paginate the FrameMaker document to remove widowed or orphaned text or list
items.

• Remove the master page from pages with no content, such as even pages at the end
of a chapter.

• Regenerate front-matter files and the index (if applicable) to update cross
references.

You will not be expected to create PostScript files for books in Latin 1 languages, such as
French, German, or Spanish. You may be required to create PostScript files for books
using multibyte characters, such as Japanese or Korean. See the L10N specification for
the list of files you’ll be expected to deliver.
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Figure 1-3 Hard Copy Process

Document and Directory Part Numbers

Silicon Graphics documents are assigned ten-digit part numbers with the format
00X-XXXX-nnn. The document’s directory name is the part number, and it contains all
the files required for a document. Localized documents use this part number and a
two-letter language code to differentiate the part number and the document’s directory
from its English counterpart. For example, 007-2825-nnnJP is the Japanese version of
007-2825-nnn. Possible language codes are shown in “Part Number Language Codes for
Localized Books” on page 13.

Most online or printed document part numbers begin with 007. Help books usually begin
with 008. The middle four digits are the base part number, and the final three digits
indicate the revision level.

Print

vendor

file.doc

file.ps

Hard copy book 
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Basic Book Set: Short Titles and Part Numbers

A short title is condensed version of a book’s full title. No more than 12 characters long,
short titles are used in the Makefile for bookbuilding and as the titles of icons representing
iconified IRIS InSight books.

A sample list of part numbers and their corresponding short titles are shown in Table 1-2.

Table 1-2 Document Name and Part Number Matrix

Part Number (VERSION) Short_Title(TITLE) Document Name (FULL_TITLE)

007-1342-nnn Desktop_UG Desktop User’s Guide

007-1366-nnn PerSysAdmin Personal System Administration
Guide

007-1859-nnn glossary Silicon Graphics Glossary of Terms
or

Global Glossary

008-2169-nnn HowDoI_Help Quick Answers

008-2172-nnn ErrorHelp System Monitor Errors Help

008-2173-nnn ErrorMessageHelp Desktop Error Message Help

008-2174-nnn InsightHelp InSight Help

008-2181-nnn ViewerHelp SGIHelp Viewer Help

007-2445-nnn ConfTestHelp Confidence Test Help

007-3088-nnn ConfTestErrors Confidence Test Errors Help

007-3486-nnn NeditHelp Nedit Help
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Part Number Language Codes for Localized Books

The two-letter language codes currently in use for books are

DE German

ES Spanish

FR French

JP Japanese

KR Korean

It is important that localized document directories include this language code as a suffix.
For example, the French document directory for the book 007-2825-nnn would be named
007-2825-nnnFR.

Standard Silicon Graphics Bookshelves

Silicon Graphics documents are usually classified as one of the following:

Administrator Administrator’s guides

Developer Programmer’s or reference guides

End User Owner’s or user’s guides

Help Online-only help books (these do not appear in IRIS InSight)

Each of these types of books has its own online bookshelf in IRIS InSight. The
BOOKSHELF variable in a document’s Makefile determines the online bookshelf where
the book appears. For a more complete description, see “Editing the Makefile” on
page 72.
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Guidelines for Translators

Adding Text

Make sure that the translation matches the source, or English document, as closely as
possible. If extra text is added to the document, it will be difficult to update the document
at a later date. For example, if the English version of a paragraph is about five lines long
and the translated version is about one page long, that means you have added too much
detail to the translation. When the book is revised, a compare and summary utility is
used to compare the old and the new English versions. The differences in the
documentation are then given to you so that you can update the old translated version.
If there is extra text in the translated version, there is no utility to ensure that those longer
paragraphs are updated properly in a later revision.

Checking Consistency

Make sure that the documentation matches the software which it is intended to support
or document. In some cases, the documentation may reference software that requires a
particular hardware item before the software will work (such as an IndyCam camera). If
you do not have this equipment, contact the Silicon Graphics localization project
manager and arrange either for the delivery of the hardware or for Localization to
complete the consistency check.

Checking Documentation

Compare the translated version of a document against its English version. Check to make
sure that:

• the table of contents has the same number of headings and that they are the correct
heading level

• the same number of paragraphs are present

• paragraphs have the same tags

• characters have the same tags

• cross references appear in the correct paragraph

• cross references are the same in format and function
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• GlossaryItem-tagged words appear in the same paragraph

• figures match the sofware

• bullets are the correct shape

• sequential lists are numbered correctly

• the index shows up in the appropriate language

• paragraphs tagged as Note, Shortcut, Hint, Tip, Warning, and Caution appear
correctly in the appropriate language

• if a glossary item is more than one word, select and tag all the words and the
character space(s) between them as GlossaryItem

• no text appears in English in the translated document unless appropriate or
absolutely neccessary

Localization Requirements

As stated in the localization specifications sent with all source files, please consider the
following points when translating a document:

• Unless your localization project manager indicates otherwise, you must supply
books that build error-free before they are sent to Silicon Graphics.

• All books should closely match the new English source.

• All character and paragraph tags should match those in the new English source.

• The same number of markers should exist in both the translated books and the new
English source and the markers should be the same as in the new English source.

• All cross references (internal and external) must work the same as the English
source.

• Index markers must be translated and work properly.

There may be instances where the English source is not error-free. If the English source
includes errors or warnings, there is no obligation on your part to fix these errors. These
errors should be brought to Silicon Graphics’ attention, however, and can be included in
your periodic status reports.
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Reference Materials

IRIS InSight Professional Publisher User's Guide, 007-2863-nnn

IRIS Insight Professional Publisher Templates, 007-2892-nnn
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2. Bookbuild Tools

This chapter describes how to install the bookbuild tools and set up a workarea. You
should be familiar with using Inst or Software Manager. The following sections are
included:

• “Required Software Packages” on page 17

• “Installing Software Packages” on page 21

• “Setting Up the Workarea” on page 29

• “Prod toolroot Contents” on page 33

• “Removing ROOT and TOOLROOT” on page 36

Required Software Packages

In addition to the build and viewing tools described in “Tools”, you need
FrameMaker 4.0 or 5.1 for IRIX or Frame 3.0 for Japanese for Solaris. FrameMaker 5.5
does not work with the build tools.

Compatibility

All of the tools assume that you are installing on a computer running the IRIX 6.2
operating system.

Tools

All of the tools described in this section should be installed in the standard default
location of /.

If you have the previous 3.5 bookbuild tools installed, see the section “Removing ROOT
and TOOLROOT” on page 36 for instructions on how to remove them.
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You need the following subsystems:

• make

• insight_dev

• prod_toolroot

• impr_rip

• impr_kanji (Japanese only)

make

make is required by the bookbuild tools to run the make command as described in
Chapter 5, “Building Online Books.”

The name of the Inst image is dev.

I dev 11/06/97 Development System, 6.2
I dev.sw 11/06/97 Development Software, 6.2
I dev.sw.make 11/06/97 Parallel Make Utilities

insight_dev

The name of the Inst image is insight_dev.

I insight_dev 11/06/97 InSight Developer Book Building Tools, 3.6
I insight_dev.books 11/06/97 Insight Developer Books, 3.6
I insight_dev.books.IPTemplate 11/06/97 Insight Developer Template, 3.6
I insight_dev.books.InProPub_UG 11/06/97 Insight Professional Publisher

User’s Guide, 3.6
I insight_dev.man 11/06/97 InSight Book Building Development Release

Notes, 3.6
I insight_dev.man.relnotes 11/06/97 InSight Book Building Release Notes, 3.6
I insight_dev.sw 11/06/97 InSight Book Building Development

Environment, 3.6
I insight_dev.sw.rules 11/06/97 InSight Book Building Rules, 3.6
I insight_dev.sw.samples 11/06/97 InSight Book Building samples, 3.6
I insight_dev.sw.tools 11/06/97 InSight Book Building Tools, 3.6
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prod_toolroot

The prod_toolroot contains productivity tools and enhanced quality assurance for the
build process. This is used by the SGI_QA variable in “Setting Workarea Environment
Variables” on page 31.

The name of the Inst image is prod_toolroot.

I prod_toolroot 01/20/98 prod_toolroot (no description)
I prod_toolroot.sw 01/20/98 Technical Publications Production Toolroot

Software
I prod_toolroot.sw.IP_templates 01/20/98 Production Additions to IPTemplates
I prod_toolroot.sw.frame_macros 01/20/98 Macros for FrameMaker
I prod_toolroot.sw.prod_gizmo 01/20/98 ProdGizmo
I prod_toolroot.sw.scripts_prod 01/20/98 Prod scripts
I prod_toolroot.sw.scripts_pubs 01/20/98 Pubs-wide scripts
I prod_toolroot.sw.special_templates 01/20/98 Special Templates

impr_rip

This subsystem is required for converting Adobe Illustrator files into gif images. You
need a license for this product. See “Getting Licenses” on page 20 for more information.

The name of the inst image is impr_base.

I impr_rip 01/20/98 Impressario 2.2.3 PostScript Renderer
(Requires Optional Impressario License)

I impr_rip.man 01/20/98 Impressario 2.2.3 PostScript Renderer Manual
Pages

I impr_rip.man.impr 01/20/98 Impressario 2.2.3 PostScript Renderer Manual
Pages

I impr_rip.sw 01/20/98 Impressario 2.2.3 PostScript Renderer
(Requires Optional Impressario License)

I impr_rip.sw.impr 01/20/98 Impressario 2.2.3 PostScript Renderer
(Requires Optional Impressario License)

impr_kanji (Japanese only)

This is necessary for building Japanese books that have Adobe Illustrator files containing
Japanese characters. You need a license for this product. See “Getting Licenses” on
page 20 for more information.
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The name of the Inst image is impr_kanji.

I impr_kanji 01/20/98 Kanji Fonts 2.0 Execution Environment
I impr_kanji.man 01/20/98 impr_kanji Manual Pages
I impr_kanji.man.fonts 01/20/98 Kanji Fonts 2.0 Manual Pages
I impr_kanji.man.relnotes 01/20/98 Kanji Fonts 2.0 Release Notes
I impr_kanji.sw 01/20/98 Kanji Fonts 2.0 for Impressario, requires

license
I impr_kanji.sw.fonts 01/20/98 Kanji Fonts 2.0 for Impressario, requires

license

Getting Licenses

You need a license for impr_rip and impr_kanji, both of which are part of the Impressario
product. You may find it necessary to get a license for the IRIS InSight Professional
Publisher. In future releases of the IRIS InSight Professional Publisher, no licensing will
be necessary.

To get a license for any Silicon Graphics product, follow the instructions given below. The
system must be owned by Silicon Graphics, otherwise you will need to purchase your
own software. You may be prompted for a SurfZone ID and password. The ID is free, but
you do have to fill out the registration at http://www.sgi.com/zone-reg.html.

1. Go to this URL and complete all relevant information:

http://www.sgi.com/Products/license.html

2. Go to the permanent license section.

3. Select Impressario and IRIS InSight Professional Publisher for your license.

4. Enter SGI LOANER in the subject header or sales order field.

The Silicon Graphics licensing department will verify that the system in question is
owned by Silicon Graphics. After verification, you will receive the license in the mail.

Instructions for installing the licenses are included with the license information.
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Installing Software Packages

The section gives you a quick overivew of Inst and step-by-step instructions using Inst
for installing the tools needed for bookbuilidng.

Once you have received all the images, such as those for IRIS InSight Professional
Publisher, prod_toolroot, and Impressario, you need to use inst or Software Manager. All
of the software, starting with the 3.6 Bookbuild Tools, are installed into the default
location of /. If there is not enough space on /, you may need to remove unneccessary
software. See “Removing ROOT and TOOLROOT” on page 36 for information on
removing old bookbuild tools.

Product Descriptions

Before installing any software from Silicon Graphics, it is important to know what the
filenames mean. This sections describes the naming conventions for installable software
products.

Product Descriptions

The product description is a file that contains information about product requirements and
the installation environment for the product. The name of the product description file is
the shortname for the product. For example, the name of the product description file for
the IRIS InSight Professional Publisher product is insight_dev.

Installation Database

The installation database is a file that contains installation information for every file in the
product. The name of the installation database is the shortname with an .idb extension.
For example, the name of the installation database for the IRIS InSight Professional
Publisher product is insight_dev.idb.

Images

An image is a collection of installable files that perform a similar or complementary
function. Typically, each software product contains at least two images. This modularity
allows for tailoring installations. For example, it is possible to install the images that
contain the executable programs of a product without installing the release notes image.
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The name of an image is the product shortname followed by an extension that describes
the image’s function. For example, insight_dev.sw is the image in the IRIS InSight
Professional Publisher product that contains files for program execution, and
insight_dev.man is the image that contains manual pages.

Subsystems

Images are composed of one or more subsystems. In a software product release, a
subsystem is the smallest installable unit of software; the files that make up a subsystem
cannot be installed individually. Subsystems are assigned three-part names of the form
product.image.subsystem. For example, insight_dev.sw.rules and insight_dev.sw.tools are
subsystems in the IRIS InSight Professional Publisher product.

Checking the Installation Directory

Example 2-1 shows you what your installation directory should look like.

Example 2-1 Directory View of the Installation Images

%ls ~/bookbuildtools
dev dev.sw64 impr_rip.man prod_toolroot
dev.books impr_kanji impr_rip.sw prod_toolroot.idb
dev.hdr impr_kanji.idb insight_dev prod_toolroot.sw
dev.idb impr_kanji.man insight_dev.books
dev.man impr_kanji.sw insight_dev.idb
dev.sw impr_rip insight_dev.man
dev.sw32 impr_rip.idb insight_dev.sw

Installing the Software

The next step is to install the software. Enter the following command:

% inst -f /pathname of dir where images are located

If the images are located on another system, you should be able to use the following
command:

% inst -f guest@name of server:/pathname of dir where images are located

After using this command, you get a screen like the one shown in Example 2-2.
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Example 2-2 Main Inst Screen

paranoia 1# inst -f guest@midas:~dvogt/bookbuildtools

Default distribution to install from: guest@midas:~dvogt/bookbuildtools

For help on inst commands, type "help overview".

Inst Main Menu

1. from [source ...] Specify location of software to be installed
2. open [source ...] Specify additional software locations
3. close [source ...] Close distributions
4. list [keywords] [names] Display information about software subsystems
5. go Perform software installation and removal now
6. install [keywords] [names] Select subsystems to be installed
7. remove [keywords] [names] Select subsystems to be removed
8. keep [keywords] [names] Do not install or remove these subsystems
9. step [keywords] [names] Interactive mode for install/remove/keep
10. conflicts [choice ...] List or resolve installation conflicts
11. help [topic] Get help in general or on a specific word
12. view ... Go to the View Commands Menu
13. admin ... Go to the Administrative Commands Menu
14. quit Terminate software installation

Inst>

Type list to list the software products contained in the directory. Example 2-3 shows an
example of typical output.

Example 2-3 Full Listing of Software Products

i N dev.books.IRIX_NetPG [d] 1780+ IRIX Network Programming Guide
i N dev.books.I_IRIX_Prog [d] 956+ Introduction to IRIX Programming
i N dev.books.IndigoMagic_IG [d] 2700+ Indigo Magic Desktop Integration

Guide
i N dev.books.T_IRIX_Prog [d] 2628+ Topics in IRIX Programming
i N dev.books.UI_Glines [d] 4736+ IndigoMagic UI Guidelines
i N dev.man.irix_lib [d] 3536+ Development Environment IRIX Manual

Pages
i N dev.man.relnotes [d] 36+ IDO Release Notes
N dev.sw.abi 11224+ ABI development environment
N dev.sw.irix_speclibs 4368+ IRIX NonShared Libraries for

Benchmarks
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i N dev.sw.lib [d] 980+ Development Libraries
i N dev.sw.make [d] 172+ Parallel Make Utilities
N dev.sw32.nonshared_lib 9488+ NonShared N32 Libraries
N dev.sw64.lib 272+ N64 Development Libraries
N dev.sw64.nonshared_lib 12816+ NonShared N64 Libraries

i N impr_kanji.man.fonts [d] 4+ Kanji Fonts 2.0 Manual Pages
i N impr_kanji.man.relnotes [d] 44+ Kanji Fonts 2.0 Release Notes
i N impr_kanji.sw.fonts [d] 26204+ Kanji Fonts 2.0 for Impressario,

requires license

N impr_rip.man.impr 32+ Impressario 2.2.2 PostScript
Renderer Manual Pages

N impr_rip.sw.impr 4272+ Impressario 2.2.2 PostScript
Renderer (Requires Optional
Impressario License)

i N insight_dev.books.IPTemplate [d] 564+ Insight Developer Template, 3.6
i N insight_dev.books.InProPub_UG [d] 752+ Insight Professional Publisher

User's Guide, 3.6
i N insight_dev.man.relnotes [d] 36+ InSight Book Building Release

Notes, 3.6
i N insight_dev.sw.rules [d] 36+ InSight Book Building Rules, 3.6
N insight_dev.sw.samples 5728+ InSight Book Building samples, 3.6

i N insight_dev.sw.tools [d] 62704+ InSight Book Building Tools, 3.6

N prod_toolroot.sw.IP_templates 92+ Production Additions to IPTemplates
N prod_toolroot.sw.frame_macros 36+ Macros for FrameMaker
N prod_toolroot.sw.prod_gizmo 32+ ProdGizmo
N prod_toolroot.sw.scripts_prod 100+ Prod scripts
N prod_toolroot.sw.scripts_pubs 48+ Pubs-wide scripts
N prod_toolroot.sw.special_templates 444+ Special Templates

Disk space summary (Kbytes): /

Current free space 139632
- Selections net change 108040+
- Temporary inst overhead 836+
= Minimum free during install 30756

Final projected free space 31592

Inst>
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Anything marked with [d] after the subsystem is marked for installation by default. Any
subsystem with a i before it will be installed. For example:

i N insight_dev.sw.tools [d] 62704+ InSight Book Building Tools, 3.6

It is not always necessary to install default images, and sometimes it may be neccessary
to install images that are not marked as default.

To install a product that is not marked for installation, enter the character i followed by
the subsystem name. For example:

Inst> i impr_rip.sw.impr

To test if the subsystem will be installed, enter, for example:

Inst> l impr_rip.sw.impr

A typical result looks like this:

Inst> l impr_rip.sw.impr
View: distribution
Status: N=new, U=upgrade, S=same, D=downgrade
Selection: i=install, r=remove, k=keep

Subsystem Types [bdrpc]: b=reBoot needed, d=Default, r=Required, p=patch,
c=Client only

i N impr_rip.sw.impr 4272+ Impressario 2.2.2 PostScript
Renderer (Requires Optional
Impressario License)

Disk space summary (Kbytes): /

Current free space 139632
- Selections net change 99484+
- Temporary inst overhead 804+
= Minimum free during install 39344

Final projected free space 40148

The N after the i indicates that the software is new. An S indicates the same version as
what is already installed on a system, and a U means that you are installing an upgrade.
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To prevent a subsystem from being installed, enter k followed by the subsystem name(s).
The sample below will not install anything that starts with dev.books. For example:

Inst> k dev.books dev.sw64.lib

Entering k * prevents anything from being installed.

Necessary Installation Files

Example 2-4 shows you what your installation should like before you use the go
command.

Example 2-4 Necessary Installation Files

Inst> l
View: distribution
Status: N=new, U=upgrade, S=same, D=downgrade
Selection: i=install, r=remove, k=keep

Subsystem Types [bdrpc]: b=reBoot needed, d=Default, r=Required, p=patch,
c=Client only

N dev.books.IRIX_NetPG [d] 1780+ IRIX Network Programming Guide
N dev.books.I_IRIX_Prog [d] 956+ Introduction to IRIX Programming
N dev.books.IndigoMagic_IG [d] 2700+ Indigo Magic Desktop Integration

Guide
N dev.books.T_IRIX_Prog [d] 2628+ Topics in IRIX Programming
N dev.books.UI_Glines [d] 4736+ IndigoMagic UI Guidelines
N dev.man.irix_lib [d] 3536+ Development Environment IRIX Manual

Pages
i N dev.man.relnotes [d] 36+ IDO Release Notes
N dev.sw.abi 11224+ ABI development environment
N dev.sw.irix_speclibs 4368+ IRIX NonShared Libraries for

Benchmarks
i N dev.sw.lib [d] 980+ Development Libraries
i N dev.sw.make [d] 172+ Parallel Make Utilities
N dev.sw32.nonshared_lib 9488+ NonShared N32 Libraries
N dev.sw64.lib 272+ N64 Development Libraries
N dev.sw64.nonshared_lib 12816+ NonShared N64 Libraries
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i N impr_kanji.man.fonts [d] 4+ Kanji Fonts 2.0 Manual Pages
i N impr_kanji.man.relnotes [d] 44+ Kanji Fonts 2.0 Release Notes
i N impr_kanji.sw.fonts [d] 26204+ Kanji Fonts 2.0 for Impressario,

requires license

i N impr_rip.man.impr 32+ Impressario 2.2.2 PostScript
Renderer Manual Pages

i N impr_rip.sw.impr 4272+ Impressario 2.2.2 PostScript
Renderer (Requires Optional
Impressario License)

i N insight_dev.books.IPTemplate [d] 564+ Insight Developer Template, 3.6
i N insight_dev.books.InProPub_UG [d] 752+ Insight Professional Publisher

User's Guide, 3.6
i N insight_dev.man.relnotes [d] 36+ InSight Book Building Release

Notes, 3.6
i N insight_dev.sw.rules [d] 36+ InSight Book Building Rules, 3.6
i N insight_dev.sw.samples 5728+ InSight Book Building samples, 3.6
i N insight_dev.sw.tools [d] 62704+ InSight Book Building Tools, 3.6

i N prod_toolroot.sw.IP_templates 92+ Production Additions to IPTemplates
i N prod_toolroot.sw.frame_macros 36+ Macros for FrameMaker
i N prod_toolroot.sw.prod_gizmo 32+ ProdGizmo
i N prod_toolroot.sw.scripts_prod 100+ Prod scripts
i N prod_toolroot.sw.scripts_pubs 48+ Pubs-wide scripts
i N prod_toolroot.sw.special_templates 444+ Special Templates

Disk space summary (Kbytes): /

Current free space 139632
- Selections net change 102388+
- Temporary inst overhead 728+
= Minimum free during install 36516

Final projected free space 37244

It is generally all right to install more susbsytems than you might actually use as long as
you have enough disk space.

Once all the appropriate subsystems are selected, you can enter the go command, which
installs all of the software with i’s in the left column.
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Inst> go
Pre-installation check .. 8%
Checking space requirements .. 16%
Installing/removing files .. 16%
Installing new versions of selected dev.sw subsystems
Installing/removing files .. 19%
Installing new versions of selected dev.man subsystems
Installing new versions of selected prod_toolroot.sw subsystems
Installing/removing files .. 21%
Installing new versions of selected impr_rip.sw subsystems
Installing/removing files .. 24%
Installing new versions of selected impr_rip.man subsystems
Installing new versions of selected impr_kanji.man subsystems
Installing/removing files .. 25%
Installing new versions of selected impr_kanji.sw subsystems
Installing/removing files .. 58%
Installing new versions of selected insight_dev.books subsystems
Installing/removing files .. 62%
Installing new versions of selected insight_dev.man subsystems
Installing/removing files .. 63%
Installing new versions of selected insight_dev.sw subsystems
Installing/removing files .. 94%
Running exit-commands .. 99%
Checking dependencies .. 100% Done.
Installations and removals were successful.
You may continue with installations or quit now.

Enter list to see what is installed. Anything that is installed should have an S in the
second column. For example:

S insight_dev.books.IPTemplate [d] 0 Insight Developer Template, 3.6
S insight_dev.books.InProPub_UG [d] 0 Insight Professional Publisher

User's Guide, 3.6
S insight_dev.man.relnotes [d] 0 InSight Book Building Release

Notes, 3.6
S insight_dev.sw.rules [d] 0 InSight Book Building Rules, 3.6
S insight_dev.sw.samples 0 InSight Book Building samples, 3.6
S insight_dev.sw.tools [d] 0 InSight Book Building Tools, 3.6

If you are satisfied with the installation, enter quit:

Inst> quit
Requickstarting ELF files (see rqsall(1)) .. 100% Done.

You are now ready to work.
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Additional Information on Inst and Software Manager

For more information on Inst or Software Manager, see the manual IRIX Admin: Software
Installation and Licensing. This can be accessed online from
http://techpubs.sgi.com/library/dynaweb_bin/0620/bin/nph-dynaweb.cgi/
dynaweb/SGI_Admin.

You can also download PDF files from
http://techpubs.sgi.com/library/lib/makepspage.cgi?007-1364-060,pdf,@Version[0].

Setting Up the Workarea

If you have been assigned to localize an English book for more than one language, create
separate directories for each language according to the naming conventions discussed in
“Document and Directory Part Numbers” on page 11. Silicon Graphics manuals typically
refer to books by part number when building online books.

Directory Tree

Figure 2-1 shows an example of a typical directory tree set up for bookbuilding several
French and German documents.
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Figure 2-1 Typical Silicon Graphics Working Directory

books

1000

007-1366-nnnDE

007-1366-nnnFR

007-1342-nnnDE

007-1342-nnnFR

007-1859-nnnDE

007-1859-nnnFR

3000

008-3088-nnnDE

008-3088-nnnFR

008-3222-nnnDE

008-3222-nnnFR

2000

008-2169-nnnDE

008-2169-nnnFR

008-2172-nnnDE

008-2172-nnnFR

008-2173-nnnDE

008-2173-nnnFR

008-2174-nnnDE

008-2174-nnnFR

008-2181-nnnDE

008-2181-nnnFR

008-2182-nnnDE

008-2182-nnnFR
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Workarea Environment Variables

Your workstation can provide information about the location of files and tools required
by the bookbuild tools. You can obtain this information by using environment variables
that you set yourself. This section covers

• “Configuring Workarea Environment Variables” on page 31

• “Setting Workarea Environment Variables” on page 31

Configuring Workarea Environment Variables

The workarea environment variables you must set are listed in Table 2-1.

Setting Workarea Environment Variables

The procedure that follows explains how to create the ~/.set_workarea file and set
environment variables in .set_workarea and .cshrc. The procedure includes instructions for
defining how the commands pushd and popd will work in your workarea. (pushd and popd
are alternatives to the cd command; they queue working directories so you can alternate
current directories without specifying a directory name.)

Note: These instructions are adapted from Building Manual Pages and Release Notes.
Please refer to that document for more information.

Table 2-1 Workarea Environment Variables

Variable File Description

ROOT ~/.set_workarea Specifies the location of the rules to be used when you
build books for IRIS InSight.

TOOLROOT ~/.set_workarea Specifies the location of the tools to be used when you
build books for IRIS InSight.

SGI_QA ~/.set_workarea Set to null (no setting). Silicon Graphics specific QA
tools. Prints values of TITLE, FULL_TITLE,
VERSION, BOOKSHELF, BOOK_ICON,
BOOK_LANG, DTD, SORT_ORDER, and HIDDEN
in the Makefile and checks for values of VERSION
and SORT_ORDER.
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1. Go to your home directory:

% cd

2. Use your favorite editor (like vi or jot) to create a new file called .set_workarea.

3. Edit your .set_workarea file. Set the ROOT and TOOLROOT variable within the
if/endif statement to the correct version of the tools, for example, /. Otherwise, type
these lines into the file exactly as they appear:

set curdir=‘pwd‘
unsetenv WORKAREA
setenv ROOT /
setenv TOOLROOT /

if ("$curdir" =~ workarea*) then
setenv ROOT /
setenv TOOLROOT /
setenv SGI_QA

endif

Note: If a .set_workarea file exists, append the if/endif statement to your existing
.set_workarea file.

4. Save the file and quit the editor.

5. Add the cd, pushd, and popd aliases to your .cshrc file:

alias cd ’cd \!* && source ~/.set_workarea’
alias pushd ’pushd \!* && source ~/.set_workarea’
alias popd ’popd \!* && source ~/.set_workarea’

These aliases call the .set_workarea file to set the appropriate environment variables.
So, when you cd/popd/pushd to a directory specified in the .set_workarea, your
environment variables are set correctly.

6. Enter the following command in all open windows so your changes will take effect:

% source .cshrc

7. Verify that the environment variables are set:

% cd ~/books
% env

Check the output of env for ROOT and TOOLROOT. Both variables should be set to
the correct version of tools.
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Prod toolroot Contents

The prod_toolroot file includes scripts that are useful for production on books.

All of the following scripts are installed in the /usr/local/bin and /usr/local/bin/prod
directories. You should add these paths to the path information in your environment
settings (usually found in your .cshrc file). The following scripts are covered in this
section:

• “helpcheck Script” on page 33

• “helpdiff Script” on page 34

• “installtestbooks Script” on page 35

• “gethelp Script” on page 35

helpcheck Script

This script checks the helpmaps in the help directory against the SGML file for a book to
ensure that the helpmaps are actually pointing to a target in the documents. To get the
full SGML file mentioned in Example 2-5, build a book using the bookbuild tools. An
artifact of the bookbuilding process is the SGML file, which is used to create the final
online book.

Example 2-5 shows the syntax for helpcheck along with the results. The results listed in the
Desktop_UG.hc file show which help topics exist in the document and which ones do not.

Example 2-5 Results From helpcheck Script

% /usr/local/bin/helpcheck help Desktop_UG.sgml > Desktop_UG.hc

% more Desktop_UG.hc

Checking help/Accessworkstation.helpmap...
access_other_user exists in Desktop_UG.sgml
Checking help/Background.helpmap...
background exists in Desktop_UG.sgml
schemes_browser exists in Desktop_UG.sgml
Checking help/SearchBook.helpmap...
srch_selectedmenu does not exist in Desktop_UG.sgml
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helpdiff Script

This script checks the new localized helpmap directory against the original English
version to make sure that only the text string that was supposed to be localized has
changed. In some cases, during the localization process the semicolons in the helpmaps
are accidentally removed. This script checks to make sure that hasn’t happened. It is
similar to running the diff command, but it ignores the third field.

Example 2-6 shows the syntax for helpdiff along with the results. The results listed in the
Desktop_UG.hd file show which helpmaps are different in the document and which ones
are the same. In the example, you find that files such as Background.helpmap and
Desktop.helpmap are correct from a structural standpoint. However, FileManager.helpmap
has what looks like three problems. These three lines should be looked at to make sure
that everything is correct. It could be that the localized version is correct and the English
version is not. If the English version is not correct, a bug should be filed against the
helpmap file. If the localized version is the problem, make any necessary corrections.

Example 2-6 Results From helpdiff Script

% /usr/local/bin/helpdiff 007-1342-130FR/help 007-1342-130/help > \
007-1342-130FR/Desktop_UG.hd

% more 007-1342-130FR/Desktop_UG.hd

007-1342-130FR/help <-> 007-1342-130/help
13a14
> Launch.helpmap
007-1342-130FR/help/Background.helpmap <-> 007-1342-130/help/Background.helpmap
007-1342-130FR/help/Desktop.helpmap <-> 007-1342-130/help/Desktop.helpmap
007-1342-130FR/help/DtSounds.helpmap <-> 007-1342-130/help/DtSounds.helpmap
007-1342-130FR/help/DtUtilities.helpmap <-> 007-1342-130/help/DtUtilities.helpmap
007-1342-130FR/help/FAXManager.helpmap <-> 007-1342-130/help/FAXManager.helpmap
007-1342-130FR/help/FileManager.helpmap <-> 007-1342-130/help/FileManager.helpmap
3d2
< 2;Desktop_UG;0;fm2;FileManager.FileManager
9c8
< 2;Desktop_UG;1;access_remote_login;FileManager.FileManager
---
> 2;Desktop_UG;1;newdir.Newdir.Help;FileManager.FileManager
13d11
< 2;Desktop_UG;0;fm5;FileManager.FileManager
30,31d27
< #0;Desktop_UG;0;file_browser;
<
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installtestbooks Script

This script installs a book from a workarea into a test directory. This is not a real
installation of the book (use Inst for that). This script must be run from the same directory
in which the book was built. The instructions are listed as comments in the script. See
“Installing a Localized Book for Testing” on page 109 for more information.

gethelp Script

This script extracts the help topics out of the individual SGML files and replaces the third
field in the helpmap with the corresponding string (or heading title). The helpmaps still
need to be viewed to ensure that the third field of each line was converted correctly. This
script can also be used to update the localized helpmaps.

Note: This script is located in /usr/local/bin/prod.

You must invoke the gethelp command from the part number directory of the book (the
same directory as the SGML files). The help directory (containing the helpmaps) must be
present. Example 2-7 shows an example of a typical English helpmap.

Example 2-7 English helpmap After Using gethelp

% more help/Background.helpmap
0;Desktop_UG;Changing the Desktop Background;0;background;Background.Background
0;Desktop_UG;Using the Color
Browser;0;schemes_browser;Background.ColorCDialog.Help

Example 2-8 shows the same Background.helpmap file after running the gethelp script on
the French version of the document. Notice that only the third field has changed. This is
the field that shows up in the pulldown Help menu of the application.

Example 2-8 Helpmap After Using gethelp on a French Document

% more help/Background.helpmap
0;Desktop_UG;Modifier le fond d'&eacute;cran;0;background;Background.Background
0;Desktop_UG;Utiliser le visualisateur de
couleurs;0;schemes_browser;Background.ColorCDialog.Help

See “Helpmaps” on page 115 for more information.
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Removing ROOT and TOOLROOT

If you have old build tools installed under a different ROOT and TOOLROOT, you must
remove them. They have been replaced by insight_dev and prod_root. To find out if you
have old build tools installed, enter

% versions -r /dirpath

For example, if a special bookbuild tools directory, such as /3.5tools, contained your old
bookbuild tools, and you typed versions -r /3.5tools, you would see output similar to
Example 2-9.

Example 2-9 Versions Output

midas 6% versions -r /d/3.5.tools
Target: /d/3.5.tools/
I = Installed, R = Removed

Name Date Description

I build_root 11/19/96 Build Tools Development Environment
I build_root.sw 11/19/96 Build Tools Development Environment
I build_root.sw.dev 11/19/96 Build Tools Development Environment
I build_root.sw.friend 11/19/96 Build Tools Ism Development Environment

I build_toolroot 11/19/96 Build Tools TOOLROOT
I build_toolroot.sw 11/19/96 Build Tools TOOLROOT
I build_toolroot.sw.tools 11/19/96 Build Tools TOOLROOT

I insight_root 11/19/96 InSight Development Environment, 3.5
I insight_root.dev 11/19/96 InSight Book Building Development

Environment, 3.5
I insight_root.dev.books 11/19/96 InSight Book Building Dev, 3.5
I insight_root.sw 11/19/96 InSight Viewer Development Environment, 3.5
I insight_root.sw.dev 11/19/96 InSight Viewer Dev Environment, 3.5
I insight_root.sw.sgihelp 11/19/96 SGIHelp Header & Library Files, 2.0.3
I insight_root.sw.xhelp 11/19/96 SGIHelp XHelp Files, 2.0.3

I insight_toolroot 11/19/96 InSight TOOLROOT, 3.5
I insight_toolroot.books 11/19/96 InSight Book Building TOOLROOT, 3.5
I insight_toolroot.books.Carberry_minimum 11/19/96 Carberry minimum, 4.3
I insight_toolroot.books.EBT 11/19/96 EBT full, 3.0b7c
I insight_toolroot.books.EBT_minimum 11/19/96 EBT minimum, 3.0b7c
I insight_toolroot.books.PBMPlus 11/19/96 PBMPlus - partial collection
I insight_toolroot.sw 11/19/96 InSight Viewer TOOLROOT, 3.5
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I insight_toolroot.sw.tools 11/19/96 InSight Viewer TOOLROOT, 3.5

I prod_toolroot 12/03/97 prod_toolroot (no description)
I prod_toolroot.sw 12/03/97 Technical Publications Production Toolroot

Software
I prod_toolroot.sw.IP_templates 12/03/97 Production Additions to IPTemplates

I prod_toolroot 05/08/97 prod_toolroot (no description)
I prod_toolroot.sw 05/08/97 Technical Publications Production Toolroot

Software
I prod_toolroot.sw.frame_macros 05/08/97 Macros for FrameMaker

I prod_toolroot 08/05/97 prod_toolroot (no description)
I prod_toolroot.sw 08/05/97 Technical Publications Production Toolroot

Software
I prod_toolroot.sw.scripts_prod 08/05/97 Prod scripts
I prod_toolroot.sw.scripts_pubs 08/05/97 Pubs-wide scripts
I prod_toolroot.sw.special_templates 08/05/97 Special Templates

I prod_toolroot 11/25/97 prod_toolroot (no description)
I prod_toolroot.sw 11/25/97 Technical Publications Production Toolroot

Software
I prod_toolroot.sw.prod_gizmo 11/25/97 ProdGizmo

The actual directory on your system may be different. To remove these old bookbuild
tools, enter the following command:

% versions -r /dirpath remove “*”

This should liberate considerable space on your disk drive.
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3. Using FrameMaker Files and IPTemplate Features

This chapter provides information on how best to use FrameMaker features to produce
online and printed books, as well as pointers to related information elsewhere in this
book.

All FrameMaker files supplied to you for localization have been authored using the IRIS
InSight Professional Publisher IPTemplates. The paragraph and character tags, tables
formats, cross-reference formats, conditional text tags, MIF markers, master pages, and
reference pages should be consistent from one file to the next.

In the process of translation, tags or markers may be unintentionally removed or it may
become necessary to replace a figure with its localized version. Instructions for restoring
or updating those tags and markers are included in the following sections:

• “Tagging FrameMaker Files” on page 40 provides some important rules for using
paragraph and character tags in your FrameMaker files.

• “Using Conditional Text” on page 43 describes conditional text settings and when
to use conditional text in your FrameMaker files.

• “Creating Online Links” on page 44 explains the different types of links and how
they appear and behave in the IRIS InSight viewer. These include automatic links,
writer-generated links, cross-reference links, and glossary links. This section also
provides guidelines and instructions for creating these links in your book.

• “Creating Index Entries” on page 48 explains how to create new index entries and
how to translate existing index entries.

• “Creating Tables” on page 49 explains how to create a table correctly using the
FrameMaker tools. If you don’t follow these instructions when creating a table, your
table might not display properly online.

• “Working With Figures” on page 50 explains how to create and import figures.

Note: While translating a book, please do not add paragraph tags, character tags, or
markers, and try to avoid deleting markers. Always use the new English version of a
document as the guideline for choosing tags and placing markers.
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Tagging FrameMaker Files

Before you begin, be sure you are using files created using IPTemplates. The example files
included with the IPTemplates in your vendor kit contain information on basic tagging
sequences and standard uses of the various tags.

This section offers some general tips for tagging.

Use Character Tags, Not Character Formats

If you want individual characters to look a certain way, be sure to use the supplied
character tags to change their look. Do not use the FrameMaker character designer tool
to simply change the format of a character. The build tools look only at tags, not at any
modifications you may have made to a character’s format.

Use Valid Tag Sequences

The example files that come with the templates contain descriptions of the various tags
and where/how they may be used. For example, don’t put the ChapTitle tag before the
ChapNum tag, or the FigTitle tag before the ChapTitle tag, or the Heading2 tag directly
after the ChapTitle tag. The online translator expects to see only certain sequences of
paragraph and character tags and produces errors for what it considers invalid
sequences.

Note: Do not create your own tags. The build tools cannot translate unknown tags.

Use the Correct Character Tag

Use the correct character tag for each tagged word or phrase. Refer to the English version
of a document for the correct character tag.
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Create Equations as Figures

The current build tools do not support FrameMaker equations. If you want an equation
in your online book, you must use snapshot or other screen-capture tools to snap a picture
of the equation. snapshot saves the equation as a .rgb file and you can import a .bw version
of this .rgb file as if it were a figure. Don’t give the equation a figure title, though, or it will
show up in the list of figures as a figure.

Don’t Use Character Tags on Tabs, Soft Returns, or Hard Returns

In general, try to keep character tags on the specific word or phrase you’re tagging,
without tagging surrounding whitespace. In particular, never apply a character tag to a
tab or a soft return1. It is easy to apply character tags to whitespace characters by mistake,
particularly when you’re working with a hanging list (note that a tab character that has
a character tag applied to it generates a warning message), so be careful.

Here are a couple of things to watch out for when tagging:

• If possible, select the word you’re tagging by double-clicking it. This keeps you
from accidentally selecting extra spaces or tabs.

• It’s sometimes difficult to see your selection clearly in FrameMaker, so it is hard to
notice if you’ve selected spaces or tabs in addition to words. If you’ve accidentally
tagged a hard return or a soft return along with the preceding word, insert a space
between the return and the word before it. Tag this space with the Default
Paragraph Format character tag. This procedure is necessary because hard and soft
returns in FrameMaker take the character tag of the character preceding them; you
can’t just tag the return itself to fix the problem.

Don’t Put Tabs in Code

Format code examples with spaces, rather than tabs. Tabs in code don’t display properly
online.

1 You can create a soft return by holding down the Shift key and pressing Enter.
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If you are copying or importing any code examples into your FrameMaker file, be sure
to turn the FrameMaker Smart Spaces feature off. Otherwise, multiple spaces will be
squashed down to one space and you’ll lose your formatting. Also, turn off Smart Quotes
so that code samples use straight quotation marks instead of curved ones. Be sure to turn
on Smart Spaces and Smart Quotes after you’re done working with code samples.

Create Valid Copyright and Trademark Symbols

Create copyright, registration, and trademark symbols according to the instructions
listed here. If you use any other method for creating these symbols, you’ll run into
problems when you convert your files to SGML.

• To create the copyright symbol (©), hold down Ctrl and press Q, then release both
keys, hold down Shift, and type a zero (0).

• To create a registered trademark symbol (®), hold down Ctrl and press Q, then
release both keys, hold down Shift, and type a nine (9). Apply the Superscript
character tag to the registered trademark symbol after it is inserted.

• To create a trademark symbol (™), hold down Ctrl and press Q, then release both
keys, hold down Shift, and press eight (8). Apply the Superscript character tag to
the registered trademark symbol after it is inserted.

Create Valid Dashes

Create en dashes and em dashes according to the instructions listed here. If you use any
other method for creating these symbols, you might create problems when you convert
your files to SGML.

• To create an en dash (–), hold down Ctrl and press Q, then release both keys, hold
down Shift, and press P.

• To create an em dash (—), hold down Ctrl and press Q, then release both keys, hold
down Shift, and press Q.

Note: En and em dashes do not translate properly in Japanese documentation.
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Footnotes

Footnotes and table footnotes are supported in IRIS InSight. To create them, use the
Footnote paragraph tag (for footnotes within text) or the TableFootnote paragraph tag
(for footnotes in tables).

Hanging Lists

A paragraph tagged as HangingList should look like the following when View >
Text Symbols is activated:

"testseite"> Dise Wahl wird im ....

When the HangingList item extends beyond the delimiter, the paragraph should look
like the following:

"testseite senden"><
Dise Wahl wird im ....

Notice that a tab comes before the soft return. The tab is required in order for the build
tools to create the structure of the online HangingList.

Using Conditional Text

The IPTemplate supports six text conditions which allow for several different outputs
from a single Frame source. Table 3-1 describes these conditional text settings and their
use. Note that some “legacy” documents include additional conditional text settings that
are no longer used but have not been removed from the Frame source. These obsolete
settings are still supported during bookbuilding.

Note: During bookbuilding, appropriate Show/Hide settings are automatically set with
the application of the conditional.doc file (which is in the FrameMaker-to-.mif translation
portion of the bookbuild tools). Conditional text show/hide settings need only be
applied as shown in Table 3-1 when the book is scheduled for print and PostScript files
must be generated as a deliverable.
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Creating Online Links

Links are connections between items of information, whether within the same online
book or between separate online documents. When the reader clicks a linked item
(whether text or an icon), either the IRIS InSight viewer scrolls to the referenced material,
or the material appears in a popup window (depending on what kind of material is
referenced).

Links fall into two groups based on whether they are automatically generated from the
structure of the document (structural links) and require no writer effort, or explicitly
created by the writer during document development (writer-generated links).

Table 3-1 Conditional Text Settings

Conditional Text Applications Show/Hide

ColorPrintOnly Applied to an anchored frame containing the separated
image for a color print book

Hide

Comment Applied to text meant as a reminder to the writer or a note to
the editor

Hide

HelpSubTopic Applied to the portion of text following a help topic that is
intended to show up as “help” in SGIHelp (if the whole
HelpTopic-to-next-HelpTopic section of text is not intended
to be help)

Hide

IndexEntry Apply to index entries; used in conjunction with the Index
marker and a Framemaker indexing macro

Hide

OnlineOnly Apply to HelpTopic paragraphs or any text that should be
seen only in the online version of a book

Hide

PrintOnly Apply to any text that should be seen only in the print
version of a book.

Show
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Automatic Links

A structural link is automatically created from the structure of the document during the
conversion process. Lists of such links appear in the various Views in IRIS InSight. All
the headings listed in the Table of Contents (TOC) view in IRIS InSight, for example, are
automatically linked to the corresponding headings within the book itself. The same goes
for all figures, tables, and media shown in their respective View lists. The result is that a
reader can click any item in a list view and the text area scrolls to the appropriate place
in the online book.

Writer-Generated Links

The writer can use various FrameMaker tools to create links to text, tables, or figures in
the same book (or in another book), between the text and the glossary, between the text
and a reference (man) page, or between the index and the text. The use of specific
markers can also allow for launchable URLs. Each link has its own appearance and
behavior.

Table 3-2 summarizes the writer-generated link types.

Table 3-2 Cross-Reference Link Types

Link Type How to Create
Appearance in
IRIS InSight Link Behavior

Cross-reference to
text or table within a
book

Use the FrameMaker
cross-reference format.

Cross-reference
appears in bold blue in
the text.

Viewer scrolls to
referenced
information.

Cross-reference to a
figure within a book

Use the FrameMaker
cross-reference format.

Cross-reference
appears in bold blue in
the text.

Viewer scrolls to
referenced figure.
Click on figure title
and figure comes up in
a restricted view.

Cross-reference to a
table within a book

Use the FrameMaker
cross-reference format.

Cross-reference
appears in bold blue in
the text.

Viewer scrolls to
referenced table. Click
on table title and table
comes up in a
restricted view.
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Cross-reference to an
example within a
book

Use the FrameMaker
cross-reference format.

Cross-reference
appears in bold blue in
the text.

Viewer scrolls to
example title.

Cross-reference to
another book (see
Chapter 4, “External
Cross References and
Multiple Link
Targets”)

Use the FrameMaker
cross-reference format
MIF markers 18 and
19.

Cross-reference
appears in red in text.

Referenced
information appears in
new viewer.

Glossary link Use the FrameMaker
character tag,
GlossaryItem; then
create a glossary entry
in your book’s glossary
file.

Item is underlined. Definition appears in a
pop-up window.

Index link Use the FrameMaker
index marker.

Index entry appears in
the Index View.
Instead of a page
number, location in the
text appears as bold
blue cross- reference to
the associated
heading/title.

Viewer scrolls to
referenced
information.

Reference page link Tag an item with the
RefPage character tag.

Item appears as red
text.

Text window appears
containing indicated
reference page.

Table 3-2 (continued) Cross-Reference Link Types

Link Type How to Create
Appearance in
IRIS InSight Link Behavior
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Creating Cross-Reference Links Within a Book

Cross-reference links within a book are created using the FrameMaker Cross-Reference
tool. They appear as bold blue text within the online document. When the reader clicks
the link, IRIS InSight either scrolls to the text if the link is to a table or text, or opens the
figure in a restricted view if the link is to a figure.

Be sure to use an appropriate cross-reference format. Note that the conversion tool
automatically removes any page numbers that appear in your cross-reference text. If
your book will appear in print as well as online, it’s a good idea to use cross-reference
formats that include page numbers to help hard copy readers navigate through the book.

Inline media Use the InlineObj and
InlineTitle paragraph
tags. See “InSight
Inline Object Tags” in
the sample chapter file
(in the samples
subdirectory of the
template directory) for
details of syntax.

Object appears in
media viewer inside
InSight viewer
window.

Media viewer controls
appropriate to media
type allow user to
manipulate or view
media.

Launch an
application
(including a World
Wide Web browser)

Use a FrameMaker
marker of type 17, as
indicated in “Markers”
in the sample chapter
file (in the samples
subdirectory of the
template directory).

Either icon in margin
or hot text, depending
on how you set up the
link.

Application comes up
in a new window.

Table 3-2 (continued) Cross-Reference Link Types

Link Type How to Create
Appearance in
IRIS InSight Link Behavior
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Creating Glossary Links

Glossary links appear as underlined words in the online text. When the reader clicks on
the word, the definition appears in a restricted view. The link itself is either to the Silicon
Graphics Glossary of Terms (007-1859-nnn, a global glossary common to all books), or to a
local glossary specific to the book. IRIS InSight searches the local glossary first (if it
exists), then searches the global glossary.

To make a glossary item, tag the word using the GlossaryItem character tag. In order to
match, the text that you tag GlossaryItem must be spelled and punctuated identically to
the text of a GlossaryTerm in your glossary.

This restriction (requiring the linked reference to be identical to the entry) can cause some
problems in localized documents. For instance, if you have a glossary entry for the term
“window,” you can’t link to it from the words “windows” or “windowing” in the text;
and it can be difficult to re-word the text to fit the format of the glossary entry. One
workaround for this problem is to create additional cross-referencing glossary entries for
those words—have an entry for “windows,” for instance, which simply says “see
‘window,’” with the word “window” linked to the glossary entry. (You can put glossary
links inside the glossary itself.)

Note: A common problem with glossary items occurs when a GlossaryItem-tagged word
has a space in front of it that is also tagged as a GlossaryItem. If a GlossaryItem is more
than one word, sometimes the space between the words is not selected as a GlossaryItem;
in these cases it is as though two different glossary items were selected.

Creating Index Entries

Creating New Index Entries

Index entries appear in the Index View in much the same way as they would in a hard
copy index. The major difference is that instead of a page number, the location in the text
appears as a bold blue cross-reference to the associated heading or title.

Use FrameMaker Index markers to create index entries for the back-of-the-book index (so
called to distinguish it from the full-text index that the build tools create).
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Online books require certain limitations in index entries:

• Index entries can be no more than three levels deep.

• You cannot put an index marker in a table footnote.

• A character format in an index entry cannot cross a semicolon or colon boundary;
for instance, <Italics>entry:subentry<Default Para Font> won’t work the
way you might expect it to. Instead, you’d have to use <Italics>entry<Default
Para Font>:<Italics>subentry<Default Para Font>.

• Special characters that result in entity references (such as special characters for
localized languages) may not sort correctly in the online index.

• Sorting ignores these characters if they appear as the first character in an index
entry: “, <, $, ., /, and <space>.

Translating or Updating Existing Index Entries

Index markers need to be translated in book undergoing localization. To do this:

1. Select Find/Change from the Edit menu.

2. Choose “Marker of Type:” from the pulldown menu next to the Find field.

3. Enter Index in the field to the right of “Markers of Type:”.

4. Click the Find button.

When an Index marker is found, select “Marker …” from the Special Menu and edit the
text. Click the Edit Marker button when the change is complete. Use the Find/Change
utility to continue searching for Index markers.

Creating Tables

Use the FrameMaker Table > Insert Table feature to create tables. Use one of the
FrameMaker table formats labeled TableXcol.

You can include footnotes in a table if you use the FrameMaker paragraph tag
TableFootnote rather than the tag Footnote.
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Working With Figures

Silicon Graphics online build tools can support six image formats for use in figures. An
extension (suffix) on the filename of the imported image designates the format of the
image. Except for FrameMaker line art, all images must be imported by reference into a
FrameMaker document, from the print subdirectory of your book directory.

Original image files and the components of composite figures are stored in a directory
called orig. During the build process, the images in orig are processed and placed into two
additional figure-related directories that the build process generates: print, which
contains processed images for the hard-copy book; and online, which contains processed
images for the online book. All image files in orig must be listed in the Makefile to specify
how the build tools should process them.

For localized books that include screen captures or “snaps” of GUIs, wait until after the
operating system or application default files are translated before capturing replacement
GUIs. A utility such as snapshot can be used snap GUIs. Composite images, or screen
snaps which have FrameMaker callouts and arrows added within the anchored frame,
may be updated in an application such as Adobe Photoshop.

If a figure is deleted and needs to be reimported, import the figure as “by reference only”
from the print directory.

Supported Image Formats

The book-building tools currently support the image formats listed in Table 3-3. Note
that composite figures (figures containing multiple imported images in a single anchored
frame) are supported for some, but not all, image formats.
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Image File Naming Conventions

The orig directory normally contains at least one image file for each figure in your book
(composite figures may use more than one file). The filename for each image file in the
orig directory must end with a standard extension (or suffix) that designates the format
of the image.

Table 3-4 shows the standard extension for each image format that is currently
supported. Notice that Table 3-4 does not include an extension for FrameMaker line art,
because line art figures are not imported files.

Table 3-3 Image Formats Supported by the Build Tools

Image Format Number of Files per Anchored Frame

RGB One or more

FrameMaker line art One or more

RGB and FrameMaker line art One or more of either

Encapsulated PostScript, including
Adobe Illustrator

One

GIF One

XWD One

Table 3-4 Image File Naming Conventions

File Format Extension

Adobe Illustrator PostScript .ai

color RGB .rgb

black and white RGB .bwa

a. These images are screen snapshots (or other RGB files) that have been converted to black and
white with the tobw utility.

Non-Illustrator PostScript .ps or .PS

GIF .gif

XWD .xwd
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Figure Subdirectories

The local working directory for a book contains three subdirectories for use with figures:

orig Place all original image files in this directory. All RGB snaps, Adobe
Illustrator files, and other original pieces of art belong in this directory.

For books that are printed in color, store the color versions for the
printed copy in orig; import a black and white FPO (For Position Only)
version into the FrameMaker document from the print directory.

Note: If you have localized the callouts on a figure, or have done a new
screen capture of a localized menu or dialog box, name the figure file
with the same name as its English equivalent.

print This directory, once you’ve populated it by using the make print
command, contains all image files that will be used in the printed
version of your book. Any image files that are imported into anchored
frames must be imported from the print directory.

online This directory contains all image files that will be used in the online
version of your book.

Adding Image Files to the Makefile

The Makefile controls the conversion of images into the appropriate format for the online
and printed versions of your book. During the build process, the build tools
automatically convert imported file references into the appropriate references to the
online directory.

Note: There should be no reason to change or add image files to the Makefile. For images
with localized callouts or GUIs, ensure that they have the same filenames as their English
equivalents before copying them into the orig directory.

PRINT_BW = Use this variable to specify original RGB color images that will be
imported as black and white images for the printed book. The files that
you list on the PRINT_BW line appear as eight-bit color GIF images in
the online book. All image files listed on the PRINT_BW line must be
stored in the orig directory with a .rgb extension.

Note: Files listed in the PRINT_BW variable can’t be part of a composite
figure.
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PRINT_COLOR =
Use this variable to specify RGB color images that will appear in color in
both the printed version and the online version of your book. The files
that you list on the PRINT_COLOR line appear as color GIF images in
the online book. All image files listed on the PRINT_COLOR line must
be stored in the orig directory with a .rgb extension.

PostScript = Use this variable to specify all PostScript images (including Adobe
Illustrator files) in your book. These images appear in color in
FrameMaker and in the online version of your book; they appear in color
in the printed version if printed on a color printer. Image files listed on
the PostScript line must be stored in the orig directory with either a .ps or
a .ai extension.

GIF= Use this variable to specify all GIF images in your book. All image files
listed on the GIF line must be stored in the orig directory with a .gif
extension. Color GIF files appear in color in the online version of your
book; black and white GIF files appear in black and white in the online
version of your book. Be sure to use GIF 87a format instead of GIF 89a;
you can use the file command to find out what format a given file is in.
Some version of the togif utility translate to GIF 89a; be sure to use the
version of togif that comes with IRIS InSight Professional Publisher.

Note: FrameMaker does not display or print GIF images.

RGB= Do not to use this variable.

XWD= Use this variable to specify all XWD images in your book. All image files
listed on the XWD line must be stored in the orig directory with a .xwd
extension. Color XWD files appear in color in both the printed and the
online versions of your book; black and white XWD files appear in black
and white in both the printed and the online versions of your book.

BW= Specifies RGB-format images that have already been converted to
black-and-white format.
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Processing and Importing Image Files

All image files used in a book must be imported into a FrameMaker document from the
print directory for a book to build successfully.

This procedure explains how to generate and populate the print directory:

1. In the book directory, run the make print command:

% make print

The make print command creates a print directory and copies the files from orig to
print, converting any formats as needed.

2. Open each FrameMaker file that should contain imported images.

There are two tags used for figures that appear inline in the hard copy: Fig and FigTitle.
The template also uses a third tag (FigTitleMargin) for figures that appear in the margin
of the hard copy. The Fig tag should not have any text in it. Its sole purpose is to serve as
placeholder for the anchored frame that holds the figure. FigTitle follows immediately
after Fig, and holds the title of the figure. FigTitleMargin holds the title of figure in the
margin.

Setting up Figures

Use this procedure to set up figures correctly:

1. Place the cursor at the end of the paragraph containing the reference to the figure.

2. Press Enter to create a new paragraph.

3. Apply the Fig paragraph tag to the paragraph.

4. Press Enter again to create a paragraph that automatically has the FigTitle
paragraph tag applied to it, and type in the figure title.

5. Place the cursor in the Fig paragraph and select Anchored Frame from the Special
menu.
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6. In the Anchored Frame dialog box, choose these settings and then click New Frame:

• Anchoring Position: Below Current Line

• Alignment: Right

• Cropped, (not Floating)

• Size: width = 5.375” and height = whatever is appropriate for your figure (the
frame can be resized once it’s inserted)

7. Import your figure by reference from the print directory into the anchored frame,
using the File > Import > File dialog box. See Figure 3-1.

Figure 3-1 Dummy Figure Title Using FigTitle Paragraph Tag

Note: To select a text object in an anchored frame, the anchored frame itself, or a text
column on a page without opening the toolbox and changing to the arrow selection tool,
simply hold down Ctrl while clicking on the object. Pressing Shift and clicking over an
object selects or deselects additional objects after the first object is selected.

Use the micro-adjust feature to move graphic objects in incremental (smaller than grid
units) steps (even when Snap is turned on): hold down Ctrl and use the arrow keys to
move objects.

TV screen

Pizza box
(anchovies optional)

Dinner tray

Remote control

Dog leash
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Things to Remember About Figures

For your book to build properly (without errors) you must follow all the rules in this list:

• Import all images by reference from the print directory. When you build your book,
the online tools automatically grab the corresponding images from the online
directory for display in IRIS InSight.

• Import each image into an anchored frame. For figures that appear within normal
page boundaries, the frame must be anchored to an empty paragraph (blank line)
that is tagged with the Fig paragraph tag.

• In order for a figure title to appear in the List of Figures in IRIS InSight, the Fig
paragraph tag has to be followed by FigTitle paragraph tag.

• Margin figures are composed of two anchored frames, one for the image and one for
the caption. The anchored frame for the caption cannot appear before the anchored
frame for the figure. If it does, the .err file for the chapter containing the margin
figure will contain an error message (see Chapter 6, “Debugging Bookbuild
Errors”).

Margin figures occasionally cause translator errors, producing the error message
“Cannot process indirect frame on page...” To correct this error, save the
FrameMaker file containing the margin figure in MIF format, then open the .mif file
and save it as a .doc file.

Table 3-5 lists the various file formats that can occur in the orig directory. For each format,
it shows the format of the file in a FrameMaker document, which produces the hard-copy
version of the figure, and the format of the file in IRIS InSight, which produces the figure
in online books. Table 3-5 also shows the file extension in the orig and print directories
and the Makefile variable where the file should be listed.

Table 3-5 Image Formats for Hard and Soft Copy

File Format
in orig

FrameMaker
File Format

IRIS InSight
File Format

Suffix
in orig

Makefile
Variable

Suffix
in print

RGB black/white RGB GIF .rgb PRINT_BW .bw

black/white RGB black/white RGB GIF .bw BW .bw

RGB RGB GIF .rgb PRINT_COLOR .clr

RGB RGB 24-bit RGB .rgb RGB .rgb
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For all image formats except black-and-white RGB, color palette information remains
unchanged during image file processing. This means that a black and white original
produces a black and white figure, and a color original produces a color figure.

For the black-and-white RGB format, color palette information is reduced to black and
white during processing. This means that both black and white and color originals
produce black and white figures.

AI Encapsulated
PostScript

EPSI GIF .ai PostScript .ai

Encapsulated
PostScript (non-AI)

Encapsulated
PostScript (non-AI)

GIF .ps PostScript .ps

GIF GIF (not viewable) GIF .gif GIF .gif

XWD XWD GIF .xwd XWD .xwd

Table 3-5 (continued) Image Formats for Hard and Soft Copy

File Format
in orig

FrameMaker
File Format

IRIS InSight
File Format

Suffix
in orig

Makefile
Variable

Suffix
in print
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4. External Cross References and Multiple Link Targets

This chapter explains how to create and test external cross references and how to find and
fix multiple link targets.

Creating Cross-Reference Links to Other Books

This section includes the following:

• “Using Markers to Create an External Book Link” on page 59

• “Using the Cross-Reference Utility to Create an External Book Link” on page 61

Using Markers to Create an External Book Link

Use the method described in this section to create a cross-book link to another book using
the FrameMaker Marker tool. Note that you can use this procedure only with target
books for which you have SGML source files.

To create a cross-book link using markers:

1. Open the FrameMaker chapter in your book and insert the cursor at the beginning
of the text where the cross-book link marker will be placed.

2. Go to the FrameMaker menu bar and select Select > Marker.

3. In the Marker dialog, select Type 18 from the Marker Type popup menu.
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4. In the Marker Text box, enter information about the cross-book link using this
syntax:

target_short_title<Space>unique_id

target_short_title is the short title of the target book, and unique_id is the identifying
number associated with the target element in the target book. To identify the correct
unique_id, look in the SGML file for the target book; find the target element and look
for an <XREFTARGET> tag nearby. For instance, in the following example the
unique_id for the TITLE element is 57332:

<SECTION2 LBL="" HELPID = ""><TITLE>Supplementary Reading<XREFTARGET
ID="57332"></TITLE><PARAGRAPH>Refer to these documents to supplement
the information in this guide:</PARAGRAPH>

5. Click the New Marker button to create a new marker containing the information
you’ve specified.

6. Move the cursor from the beginning of the text where the cross-book link will be
placed to the end of the text.

7. From the Marker dialog box, select Type 19 from Marker Type. Leave the Marker
Text box empty.

8. Click the New Marker button to create a new empty marker of type 19.

The result is a piece of your document with this structure:

<type-18_marker>text<type-19_marker>

text is the text that will be marked as a link, the type-18 marker contains the name of the
target book and the ID of the target element, and the type-19 marker is empty (a
placeholder to indicate the end of the cross-reference text).

Note: links:cross-book:creatingUnless the text between the markers is a document title,
the text between the two markers cannot contain character tags. In the case of a document
title, tag the document title and both markers with the DocTitle character tag. links:to
another book
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Using the Cross-Reference Utility to Create an External Book Link

The following procedure explains how to create a link to another book using the
FrameMaker cross-reference utility. Note that in order to create a cross-book link using
this method, you need to have access to the FrameMaker document files that were used
to create the book to which you are linking. You also need to know the target book’s short
title. The short title can be obtained from the target book’s Makefile.

This procedure is a bit tricky because you have to specify both the target filename and
the short title of the target book. To make a cross-book link, follow these steps:

1. Obtain a copy of the target book’s document files and Makefile. Place the copy in a
directory named short title (the short title of the target book), or else create a
symbolic link named short_title that links to the directory containing the copy of the
target book. The directory or symbolic link can be anywhere in your filesystem, as
long as it’s called short_title.

2. Open up the target file in FrameMaker. When opening it, be certain to navigate to
the file by way of the directory or symbolic link named short_title; if you don’t do
this, your link won’t work.

3. Open your file that will contain the cross-book cross reference and place the cursor
where you want the cross reference to go.

4. From the Special menu in your document window, choose “Cross-Reference... “

5. From the Source Document menu in the resulting dialog, select the name of the file
that contains the section you want to reference.

6. Choose the Source Type called Cross Reference Markers.

7. Select the appropriate Reference Source.

Note: The Cross Reference Markers list is a list of FrameMaker cross-reference
targets in the target file. If the target you want to reference does not appear in the list
of Cross Reference Markers, then it does not have an associated cross-reference target
and you cannot reference it.

8. Select a cross-reference format.

9. Click the Insert button.

10. Remove the target document from your system using your usual procedures.
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Note: Be sure to use separate directories for different language versions of the same
book. The same TITLE is used for the same book in all languages. For example,
PerSysAdmin is used for the German, French and English versions of the same book.
IRIS InSight checks the lang environment variable and uses the TITLE (PerSysAdmin)
from the appropriate lang directory. If lang is set to DE, the German PerSysAdmin is used.

Determining If a Book Has External Book References

After building the book, use more or jot to view the *.full file. Example 4-1 shows the
portion of the file specific to links.

Example 4-1 *.full File Quality Assurance Report for Links

=== Desktop_UG Link QA report file ===

Link targets appearing multiple times in book:
----------------------------------------------

Unresolved References present in this book: none

External Book References present in this book:
PerSysAdmin appears 16 time(s)

PerSysAdmin is externally cross-referenced 16 times in this manual.

Testing External Cross-References

To test external cross-references, all the affected books must be installed. For the book in
Example 4-1, the Desktop User’s Guide and Personal System Administration Guide must be
installed before testing can be done. To install books, use the installtestbooks script as
described in “Installing a Localized Book for Testing” on page 109. Then launch IRIS
InSight, choose the appropriate bookshelf, and open the book by clicking the book’s icon.
An IRIS InSight viewer appears and shows the first chapter or introductory section of the
book along with its Table of Contents.
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Finding Cross References in IRIS InSight

To find the cross references in IRIS InSight:

1. Enter the following line of text in the Find box:

<EXTREF>

2. Click the Search button.

All the external cross references in the IRIS InSight book are highlighted. If you look at
the top of the Table of Contents for the IRIS InSight book, you see a number that indicates
how many times an external cross reference occurs.

To test the external cross references, scroll through the book to the locations indicated by
the search results and look for bold red text. All red text indicates external cross
references or launchable reference pages.

Testing the Link

Click the external cross reference (red text). Another IRIS InSight viewer opens and
displays the linked book. The linked book shows either its first chapter or introductory
section or a specific heading for which the link was established. Continue checking all
external cross references.

If the cross-referenced book is not installed, or if the link was incorrectly created, a dialog
box, such as shown in Figure 4-1, appears.

Figure 4-1 Example of a Link That Cannot Be Followed
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Notice the title of the book that cannot be followed is SiteAdmin. This is the short title of
the book. A typical short title is a series of initials or an abbreviation sometimes separated
by an underscore. If you see a book’s part number in the IRIS InSight Warning dialog box,
the link did not work because part numbers cannot be used in place of the short title. If
the short title format appears correct but doesn’t work, check to be sure the short title is
spelled correctly.

Multiple Cross Reference Targets

The section explains the following:

• “Cross-Reference Targets” on page 64

• “How Multiple Cross References Target Occur” on page 65

• “How to Fix Multiple Cross Reference Targets” on page 67

Cross-Reference Targets

Hypertext books incorporate cross references and cross-reference targets. A cross
reference is an item you click in order to jump to another location. The target is the
location where you end up after clicking on a cross reference.

While reading an online document, the reader sees most of the text in black but
occasionally some text in blue. This blue text is the cross reference. In the example shown
in Figure 4-2, the cross reference is referring to Figure A, and Figure A is located two
paragraphs below the cross reference. When the reader clicks on the blue “Figure A” text,
they are automatically jumped to the image and title for Figure A.



Multiple Cross Reference Targets

65

Figure 4-2 Diagram of Cross Reference Targets

How Multiple Cross References Target Occur

Multiple cross references targets usually occur when a writer copies a chunk of text,
including the target markers, from one document file and then pastes it into another
document file.

Once a figure title (tagged as FigTitle) is created in FrameMaker, a cross reference can be
made to FigTitle. Figure 4-3 shows an example of a figure title that has no cross reference
linking to it.

   when the person

made a cross reference
Title that was made that
se see Figure A below

en the writer does this,
e to look at the text for

document

Figure A   An Exam

Cross reference

Cross reference target
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Figure 4-3 Figure without a Cross Reference Target Marker

Figure 4-4 shows a figure title after a cross reference target marker was made. Notice the
bold T symbol after the text “Figure A.” The T symbol is the marker that is automatically
generated when a cross reference is created.

Figure 4-4 Figure with a Cross Reference Target Marker

Once an anchored frame and its figure title and the cross reference are created, a writer
might copy the figure and figure title (and the cross reference marker) and then paste it
somewhere else in the document. If you were to look at the text for the marker in
Figure 4-4, it would look like this:

24340: FigTitle: Figure\ 1-3 A Figure with a Cross Reference Target
Marker

You can see this for yourself in a Frame document by selecting the marker and choosing
Marker ... from the Special menu. The number 24340 is the unique identifier that is used
by the online build tools to create Targets. If the marker is copied, the unique identifier is
copied with it. So if the figure title for Figure 4-4 were copied and used for Figure 1-4, the
marker for Figure 1-4 would look like:

24340: FigTitle: Figure\ 1-4 A Different Figure

Figure A. An Example Figure Without a Target Marker

Figure A     An Example Figure With a Target Marker

Cross reference (target) marker
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Notice that the number at the beginning of the string is exactly the same. This poses a
problem for the tools, which look primarily at this number and not the title. The tools
ignore the figure number and title that show up in the marker box. The tools create a
figure number and title from other information supplied, such as autonumbering.

Note: Multiple cross-reference targets are no longer a problem in some versions of
FrameMaker.

How to Fix Multiple Cross Reference Targets

This section explains how to identify and fix multiple cross reference targets.

Identifying Multiple Cross References

In the *.full file for the 3.4 and subsequent build tools, there is a section that identifies
multiple cross reference targets. The first step in fixing the problem is to identify the
targets.

In the *.full file you may get output that looks like the following:

Link targets appearing multiple times in book:
----------------------------------------------
48482 : Bouton de la barre d’outils permettant d’afficher et de
cacher l’&eacute;tag&egrave;re.
48482 : Bouton de la barre d’outils permettant d’afficher les
fichiers images.
60723 : Utiliser la barre du chemin d’acc&egrave;s.
60723 : Utilisation de la barre du chemin.
93693 : Commande &ldquo;Chercher ic&ocirc;ne&rdquo;
93693 : Commande &ldquo;Chercher ic&ocirc;ne&rdquo;

The five-digit number at the beginning of each string is in the list at least twice. The error
report lists only the unique identifier and the title, and nothing else.

To locate which FrameMaker document has these multiple target markers, use the grep
command as follows:

1. Use grep to determine which document(s) contain the target markers.

grep 60723 *.sgm



68

Chapter 4: External Cross References and Multiple Link Targets

This should produce something that looks like the following:

ch10.sgm:<SECTION3 LBL=”” HELPID = “fmcon_pathbar”><TITLE>Barre du
chemin</TITLE><PARAGRAPH>La barre du chemin est la petite barre
grise affich&eacute;e au-dessus du champ du chemin. Elle vous permet
de passer directement d’un r&eacute;pertoire &agrave; un autre
gr&acirc;ce &agrave; un petit bouton affect&eacute; &agrave; chaque
r&eacute;pertoire du <GLOSSARYITEM>chemin</GLOSSARYITEM>. Cliquez
sur l’un d’eux pour afficher le contenu d’un r&eacute;pertoire (voir
<XREF IDREF=”60723”
TYPE=”GRAPHIC”>Figure&nbsp;10-3</XREF>).</PARAGRAPH>

ch10.sgm:<PARAGRAPH><FIGURE><GRAPHIC FILE=”pathbar.gif”
POSITION=”INLINE” SCALE=”FALSE”><CAPTION LBL=”11-3”><PREFIX>Figure
10-3 </PREFIX><XREFTARGET ID=”60723”>Utilisation de la barre du
chemin.</CAPTION>

ch4.sgm:<SECTION3 LBL=”” HELPID = ““><TITLE>Utiliser la barre du
chemin d’acc&egrave;s dans l’outil de recherche
d’ic&ocirc;ne</TITLE><PARAGRAPH>La barre du chemin d’acc&egrave;s
est la barre grise situ&eacute;e au-dessus du champ de saisie rose.
Elle vous permet de vous d&eacute;placer d’un r&eacute;pertoire
&agrave; l’autre, sans entrer son nom complet. Elle contient un
petit bouton repr&eacute;sentant chaque r&eacute;pertoire dans le
<GLOSSARYITEM>nom du chemin</GLOSSARYITEM>. Cliquez sur un bouton
pour afficher le contenu de ce r&eacute;pertoire (voir la <XREF
IDREF=”60723” TYPE=”GRAPHIC”>Figure&nbsp;4-4</XREF>).</PARAGRAPH>

ch4.sgm:<PARAGRAPH><FIGURE><GRAPHIC FILE=”pathbar.gif”
POSITION=”INLINE” SCALE=”FALSE”><CAPTION LBL=”4-4”><PREFIX>Figure
4-4 </PREFIX><XREFTARGET ID=”60723”>Utiliser la barre du chemin
d’acc&egrave;s.</CAPTION>

Notice there are four locations where this ID number occurs. The number shows up
twice in ch4.sgm and twice in ch10.sgm. The XREF IDEF is the cross reference and the
XREFTARGET is the cross reference target. Because there are two targets using the
same cross reference ID, this configuration will not work.

2. Either remove the target in ch4.sgm or the target in ch10.sgm and establish a new
cross reference to the target.

Remove the target that has the fewest cross references pointing to it.

When a cross reference is clicked in the online version of the book, it starts searching the
document from the beginning for the matching target and stops at the first one it reaches.
For the information listed above, clicking the cross reference for Figure 10-3 jumps to
Figure 4-4 because it occurs first in the document.
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Cross Reference Target Scenarios

Scenario 1: A document has two targets and one cross reference.
If the cross reference refers to the first target, then the document will work.
If time permits, you should delete the target that is not being used.

Scenario 2: A document has two targets and one cross reference.
If the cross reference refers to the second target, then the document will not work.
You must delete the target that is not being used.

Scenario 3: The document has two targets and several cross references pointing to one
target and only one cross reference pointing to the other target.
You should delete the target that has only one cross reference pointing to it.
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5. Building Online Books

The book building process creates SGML files from FrameMaker source files and
generates the additional files required to build manuals that are viewable with IRIS
InSight and SGIHelp. The build process also generates error reports that are used to
debug source files so that, after a number of iterations, an error-free online document is
created.

Before you can build a book, ensure that your workarea is ready. Install the book building
tools as described in “Installing Software Packages” on page 21. Set up your workarea as
described in “Setting Up the Workarea” on page 29.

The build process is invoked with the make command, which takes a variety of
arguments. To build a book, the make command reads a file called Makefile, which
contains information that defines the built book. Once a book is built, you can proofread
it with IRIS InSight to spot any errors in the online version.

This chapter explains how to edit a Makefile, build a localized book, generate error
reports, and view the built book with IRIS InSight. The chapter includes these sections:

• “Editing the Makefile” on page 72

• “Files and Directories Generated by make” on page 75

• “Arguments to the make Command” on page 77

• “Choosing a make Command Argument” on page 78

• “Building the Localized Book” on page 82

• “If make Doesn’t Work” on page 83

• “make book Error Messages” on page 84

Note: The build process will go more smoothly if you generate and update the
FrameMaker bookfile and compose and import localized figures before beginning the
build.
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Editing the Makefile

The Makefile file specifies the FrameMaker files that compose the book and information
about the figure files in the book. Makefile also specifies the short title of your book, which
is used for hypertext links and appears in the online icon of the book. The short title also
specifies foreign language attributes and determines the bookshelf where the book is
displayed for selection by users. “Basic Book Set: Short Titles and Part Numbers” on
page 12 shows some examples of short titles. An edited version of the Makefile file must
be stored in your local working directory.

Table 5-1 lists the files that you should and should not include in the Makefile.

Before you start the bookbuild, check to be sure that the parameters listed in Table 5-2 are
correct in the localized Makefile.

Table 5-1 Files to Include and Omit in Makefile

Include Omit

Front matter file Table of Contents

Introduction or Preface file List of Figures

Chapter files List of Tables

Appendix files Index

Glossary file Book file

Table 5-2 Makefile Parameters for WorldView European

Parameter German French Spanish

TITLE short_title
(same as English)

short_title
(same as English)

short_title
(same as English)

FULL TITLE Localized book title Localized book title Localized book title

VERSION XXX-XXXX-XXXDE XXX-XXXX-XXXFR XXX-XXXX-XXXES

BOOKSHELF

help books /usr/share/Insight/library/
de_bookshelves/Help

/usr/share/Insight/library/
fr_bookshelves/Help

/usr/share/Insight/library/
es_bookshelves/Help
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For European books, the following line needs to be inserted between the BOOK_LANG
and DTD parameters:

BOOKSUBSYSTEM != echo `echo $(BOOK_LANG) | tr ‘[a-z]’
‘[A-Z]’`_$(BOOKSUBSYSTEM)

Table 5-3 lists the parameters for Japanese books.

end-user books /usr/share/Insight/library/
de_bookshelves/
SGI_EndUser_Deutsch

/usr/share/Insight/library/
fr_bookshelves/
SGI_EndUser_Francais

/usr/share/Insight/library/
es_bookshelves/
SGI_EndUser_Spanish

admin books /usr/share/Insight/library/
de_bookshelves/
SGI_Admin_Deutsch

/usr/share/Insight/library/
fr_bookshelves/
SGI_Admin_Francais

/usr/share/Insight/library/
es_bookshelves/
SGI_Admin_Spanish

BOOK_ICON

help books generic generic generic

end-user books sgi_end_user sgi_end_user sgi_end_user

admin books sgi_admin sgi_admin sgi_admin

BOOK_LANG de fr es

DTD SGIDOC SGIDOC SGIDOC

DOC_TYPE MANUAL MANUAL MANUAL

SORT_ORDER precede with “#” precede with “#” precede with “#” for all except
IRIX Admin books, then use
English sort order number

HIDDEN

for help books TRUE TRUE TRUE

for all others FALSE FALSE FALSE

Table 5-2 (continued) Makefile Parameters for WorldView European

Parameter German French Spanish
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Table 5-3 Makefile Parameters for WorldView Japanese

Parameter Japanese

TITLE short_title
(same as English)

FULL TITLE English book title followed by “(Japanese)”

VERSION XXX-XXXX-XXXJP

BOOKSHELF

help books /usr/share/Insight/library/ja_JP.EUC_bookshelves/Help

end-user books /usr/share/Insight/library/ja_JP.EUC_bookshelves/SGI_EndUser_Japanese

admin books /usr/share/Insight/library/ja_JP.EUC_bookshelves/SGI_Admin_Japanese

BOOK_ICON

help books generic

end-user books sgi_end_user

admin books sgi_admin

BOOK_LANG ja_JP.EUC

DTD SGIDOC

DOC_TYPE MANUAL

SORT_ORDER Precede with “#” for all except IRIX Admin books, then use English sort order number

HIDDEN

for help books TRUE

for all others FALSE

BOOK_FILES List .doc files
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Files and Directories Generated by make

You can run make with a number of different arguments. The argument that you use
determines the generated files that result from the build. The make command produces
two different types of files: intermediate files and error files. Intermediate files are
artifacts of the build process. make must produce these files in the course of creating an
online book and they can be used to speed up book builds when only part of the book
source has changed. They are also sources for error files, which are reports of various
types of source errors detected during the build process. Generating error files is not a
necessary step in the build process and, though it is generally not recommended, it is
possible to create on online book without generating any error files.

Note: For instructions on how to find and fix errors reported in the various error files,
see Chapter 6, “Debugging Bookbuild Errors.”

As the final step in the build process, make produces a directory called
~/books/parent_directory/partnumber that contains the online version of the book. See
“Viewing and Testing an Uninstalled Book” on page 107 for instructions on how to view
a built book.

Because the build process is a sequence of steps, make commands that take source files
closer to a finished online book necessarily require that all earlier steps are completed.
Likewise, error files that require certain intermediate files will cause those files to be
updated, if necessary, before an error report is generated.

Figure 5-1 shows where the various intermediate and error files are produced during the
build process.
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Figure 5-1 Files Produced During the make Process

Intermediate Files

make generates a sequence of intermediate files in the process of creating an online
document. Some are specific to individual source files; others are compilations of
information generated from all the source files for a book. All of these files appear in your
document directory. They are generated automatically as part of the online build process.
However, by using different make commands, you can produce various sets of these files.

.mif files These are ASCII versions of the FrameMaker .doc files. The SGML
translation software reads and converts theses files to SGML.

.sgm files These are individual SGML files, one for each FrameMaker file listed in
the Makefile. They are produced from the .mif files by the SGML
translation software.

shortname.idx file
This file contains index information for the SGML version of the book.

file1.doc
file2.doc

file3.doc file1.mif
file2.mif

file3.mif

file1.sgm
file2.sgm

file3.sgm

file1.err
file2.err

file3.err

book.idx

book.sgml

books/

Save as

mkbook

Fasttag

Indexgen

book.full
book.err
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booklist.txt file This file contains the bookshelf, book icon, language, title, short_title,
part number, and hidden variable information from the Makefile.

shortname.sgml file
This file contains the concatenated SGML for all the files listed in the
Makefile. It also includes all the information from the shortname.idx file.

Error Files

Error files list errors from the various intermediate files. For instructions on how to find
and fix errors, see Chapter 6, “Debugging Bookbuild Errors.”

.err files A .err file contains errors and warnings generated from the
corresponding .sgm or .sgml file. You should fix all messages labeled
ERROR, but you may ignore the messages labeled WARNING.

shortname.full file
The make book.full command generates a file called shortname.full that
contains a complete error report for the entire book. This is the only error
report that contains information on links.

books Directory

When you run a version of make that generates an online book, it produces a directory
called ~/books/parent_directory/partnumber that contains the online version of the book.
See “Viewing and Testing an Uninstalled Book” on page 107 for instructions on how to
view a built book.

Arguments to the make Command

The make command takes many arguments, giving you flexibility to build different pieces
of your book or selected error files. Because the build process is a sequence of steps, make
commands that require more steps will necessarily take longer (Figure 5-1 shows the
basic sequence).

A complete book build can take anywhere from 15 seconds to 30 minutes or more,
depending on the size of the book, the speed of your workstation, and the amount of
activity on your workstation. Subsequent builds take less time, depending on the
number of source files that you edited since your previous build.
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Table 5-4 lists the commands for the entire book. For any command in Table 5-4, you can
substitute the short_title of your book for book.

Table 5-5 lists the commands for individual files. Use these commands on individual
FrameMaker files.

Choosing a make Command Argument

The make command argument that you choose depends on the stage of development of
your book. Use these recommendations as a general strategy for choosing a make
argument:

• Run make book.full on a book fairly early in the development process to generate
error reports that you can use to begin debugging. Try and clean up as many of
these errors as possible before creating your first viewable book.

Table 5-4 make Commands For the Entire Book

Command Output

make book.sgml shortname.sgml file from individual filename.sgm files

make book.err shortname.err error/warning report from the shortname.sgml file

make book a books subdirectory containing a viewable book from the
shortname.sgml file and figures in the online directory

make book.full shortname.full file (containing all error information, including
link error reports that aren’t available from any other make
command)

Table 5-5 make Commands For Single Frame Files

Command Output

make filename.mif Frame MIF file from filename.doc

make filename.sgm SGML file from filename.mif

make filename.err error/warning report on filename.sgm
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• After cleaning up many of the errors from your initial make book.full, you can
produce .err files for individual source files as you continue development. You
should also produce periodic make book files to monitor the progress of your online
book.

• Finally, you must run make book.full and verify that your shortame.full file contains no
errors that you should fix. Then run make book to make sure the book is viewable
with IRIS InSight, that all figures and tables work, and that the book looks the way
you want it to look.

The make commands provide some information as they run; this information appears in
the window from which you issued the command. If a make command encounters an
unresolvable error, an error message and prompt are posted. If a make command
terminates abnormally, see “If make Doesn’t Work” on page 83 for suggestions about
how to find the problem.

For instructions on how to find and fix errors that appear in the various error reports
generated by make, see Chapter 6, “Debugging Bookbuild Errors.”

Initial make: make book.full

As a first step in the debugging process, use the make book.full command to build the
SGML files with full error reports. This does not produce a viewable book. Try to
eliminate as many of the easy, obvious errors as you can before you try and view your
book. After you’ve fixed the errors, you can build the viewable book using make book.

To run make book.full, follow this procedure:

1. Close all your FrameMaker files.

2. Change to your local working directory.

cd ~/books/parent_directory/partnumber

3. Follow the directions in “Building European Books” on page 82 for building
European language books or “Building Japanese Books” on page 83 for Japanese
language books.
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The make book.full command converts your FrameMaker files into SGML and creates a
complete error report file that you can use to “debug” your book. (Chapter 6,
“Debugging Bookbuild Errors” explains how to do this.) This complete error report is
called shortname.full, where shortname is the short_title of your book. make book.full
usually takes between 30 seconds and 30 minutes to convert a new book, depending on
the size and contents of the book.

Debugging Individual Files: filename.err

It’s rarely worth trying to rebuild the entire book every time you make a change. This
takes time and CPU cycles, and in many cases the amount of noticeable change is
minimal. A better strategy is clean up and rebuild files individually. This way, you can
work on some files while others are building in the background.

The error report you need to produce is the .err file. To produce a .err file for a single
source file, enter

make filename.err

See Chapter 6, “Debugging Bookbuild Errors” for instructions on fixing errors.

Book Error Files: book.err

make book.err produces concatenated files containing error information for entire books.
This can be very helpful, but it can take some time if a number of your source files have
changed and make has to go back and produce all the required intermediate files before
creating your error report. Be sure you really want to do this rather than produce
individual .err files.

Note: If you just want to see a concatenated version of all your .err files, use this
command: more *.err. To save the output in a file, add > filename to the end of your
command.

To produce a .err file for a book, enter

make book.err
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Making a Viewable Book: make book

If you want to view your book online and aren’t interested in the error reports:

1. Close all your FrameMaker files.

2. Change to your local working directory:

cd ~/books/parent_directory/partnumber

3. Enter the make book command:

make book

This command builds the files needed to display your book in the IRIS InSight viewer.
“Viewing and Testing an Uninstalled Book” on page 107 explains how to view the book
in IRIS InSight.

Verifying an Error-Free Book: make book.full and make book

The last thing you should do is to run make book.full to verify that you have cleaned out
all the errors in your book, then run make book to verify that your online book builds and
that it looks the way you want it to. Chances are at least some (if not most) of your files
have not been touched since you last built them (either individually or as part of a book
build), and make is smart enough to use intermediate files if the source remains
unchanged.

To build your book with make book.full:

1. Close all your FrameMaker files.

2. Change to your local working directory:

cd ~/books/parent_directory/partnumber

3. Enter the make command:

make book.full

4. To produce the viewable online book, enter:

make book



82

Chapter 5: Building Online Books

Building the Localized Book

Use the same steps to build a localized book in your workarea as you would an English
book. For Japanese books, move the .doc files to a separate subdirectory named docs prior
to starting the build on a Silicon Graphics workstation. The build tools do not work on
FrameMaker for Japanese files, but instead require the .mif files to build the book.
European language books can be built directly from their FrameMaker source.

Note: It is not necessary to change the show/hide settings for conditional text prior to
building books. A template with the correct settings, conditional.doc, is automatically
applied during the .doc to .mif translation of the book build.

Building European Books

As described in “Building the Localized Book,” European books are built from their
FrameMaker source.

To build the book:

1. Generate the SGML files and error reports:

% make book.full

2. Check the .full file to make sure there are no errors or unresolved cross references:

% more *.full

3. If an error or unresolved cross reference exists, and if the error is correctable without
the aid of a linguist, make the correction and rebuild the book.

To install the book, follow the directions in “Installing a Localized Book for Testing” on
page 109.

To set up the side-by-side test of a European manual against its English equivalent,
follow the directions in “Preparing for Comparative Testing” on page 109.
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Building Japanese Books

As described in “Building the Localized Book,” Japanese books cannot be built from their
FrameMaker source.

1. Move the .doc files to a separate subdirectory named docs prior to starting the build:

% mkdir docs

% mv *.doc docs/

The build tools do not work on FrameMaker for Japanese files, but instead use the
.mif files to build the book.

Note: You do not need to change the suffix of the filenames in the Makefile when
building from .mif files. The tools recognize that .mif files exist for the .docs listed in
the Makefile and perform the bookbuild by starting with the mif-to-sgm translation.

2. Generate the SGML files and error reports:

% make book.full

3. Check the .full file to make sure there are no errors or unresolved cross references:

% more *.full

4. If an error or unresolved cross reference exists, and it is correctable without the aid
of a linguist, make the correction and rebuild the book.

To install the book, follow the directions in “Installing a Localized Book for Testing” on
page 109. To set up the side-by-side test of a Japanese manual against its English
equivalent, following the directions in “Preparing for Comparative Testing” on page 109.

If make Doesn’t Work

If a make command doesn’t work, use these suggestions to correct the problem:

• Try to interpret the error message. See “make book Error Messages” on page 84 and
Chapter 6, “Debugging Bookbuild Errors,” for error messages and their meanings.

• Make sure the permissions are right: you need permission to read, write, and
execute the Makefile.

• Check the Makefile to make sure all the filenames are spelled correctly, and that there
are no extra spaces after the short_title or backslashes (\).
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• Check that your list of FrameMaker files includes a backslash (\) at the end of each
line except the last.

• Make sure that any pathnames derived from automount are less than 48 characters
long.

• Make sure your online tools and book files are where the make book commands think
they should be:

– “Installing Software Packages” on page 21 describes where the bookbuild tools
should be installed.

– “Setting Up the Workarea” on page 29 describes how and where to set the
relevant variables.

– If your files aren’t named properly, make book won’t work. FrameMaker files
must end in the .doc suffix and RGB figures must end in the .rgb suffix.

• Try using make -n book.full (or use -n with any of the make commands). This tells you
exactly what make is trying to do. Look for extra spaces, misspelled filenames, or
anything else that doesn’t look quite right.

If you can’t find the problem, get help from your production editor.

make book Error Messages

This section lists some specific error messages and their causes.

Error message:

FrameMaker reports error -1 “File already locked by login @ machine on date
*** Error code 1
smake: 1 error

login is a login name (probably yours), machine is a machine name (probably yours), and
date is a date (probably the current date). This means make book can’t open one (or more)
of the FrameMaker files because it’s locked. Close all your FrameMaker files and try
again. If you don’t have any open FrameMaker files, look through your book directory
and remove any files that end in .lck. Try make book again. Another possible problem
could be that someone else has logged in to your machine and moved or opened your
files.
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Error Message:

========Building master SGML File========
cat: cannot open .sgml.tmp
*** Error code 2
---Shortname ---
cat: cannot open .sgml.tmp
***Error code 2
smake: 2 errors

Here, Shortname is the short_title of your book. This error message isn’t quite so
informative. If you get something like this, open your Makefile and look at the line that
lists the short_title of the book. Look for extra spaces or punctuation. In this case, there is
an extra space following the short name of the book. Make sure the short name listed here
is the same as the directory name for your FrameMaker files.

Error Message:

"Makefile", line 16: Could not find /e/templates/make/commonbookdefs
"Makefile", line 51: Could not find include file ’${COMMONBOOKRULES}’
Fatal errors encountered -- cannot continue

The online tools are not properly installed.

Error Message:

--- shortname.sgm.mif ---
starting maker ...

No call from FrameMaker after 360 seconds
Giving up.
maker: Using //e/frame/.fminit2.0.ps

Note: This example is not applicable to Japanese books.

Here, shortname is the short_title of your book. This message means that the tools can’t
start up FrameMaker. If you’re running automount, that’s probably your problem. Kill
automount. Otherwise, it’s probably your network connection to king. Make a copy of
the /e/.env file, putting it in your home directory. Edit your new .env file, changing the
FMHOME variable to point to your local copy of FrameMaker. Then, enter

source ~/.env

Try to make the book again. If it’s still unsuccessful, contact your production editor.
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6. Debugging Bookbuild Errors

This chapter describes the errors that can occur when FrameMaker files are converted to
SGML format for online viewing. It compares the FrameMaker and SGML versions of a
sample file and identifies the intermediate files that are created to store errors in the
translation process. It also lists some common error messages and explains how to
correct them.

This chapter contains these sections:

• “About Error Messages” on page 88 discusses error messages and the basic process
for finding and resolving them.

• “Error Files” on page 88 lists and describes the various files generated by the online
tools during the conversion to SGML.

• “About SGML” on page 88 discusses SGML and provides a simple example of an
SGML file.

• “Checking the .full File” on page 93 tells you how to look at the .err files and .full file
for error messages generated during conversion.

• “Finding and Fixing Errors” on page 97 explains how to find error messages and
warnings in the .sgm files, how to pinpoint the location of errors in the FrameMaker
files, and how to interpret error messages. This section also lists some common .sgm
file error messages and their causes.
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About Error Messages

While your book is in development, even if your make command completes successfully
(that is, doesn’t terminate prematurely with a make or smake error), chances are that the
content of your book still contains errors. These errors usually involve tags and
structures that the translator considers invalid. The conversion tools report such
problems as error messages in error files. Before you check in the final version of your
book, you must examine the error messages, fix the problems that caused them, and
build a clean version of your book with the make book.full command. (A “clean” book is
one which generates no error messages or link problems during conversion.)

Error Files

Depending on the specific make command you run, you can generate a number of
different error files. (See Chapter 5, “Building Online Books,” for more information on
make commands.) The .full and .err files in this list are the most useful files for error
tracking:

.err file A .err file contains errors and warnings generated from the
corresponding SGML file, as well as information on obsolete or
unrecognized tags from the corresponding .mif file. You should fix all
messages labeled ERROR, but you may ignore the messages labeled
WARNING.

short_title.full file
The make book.full command generates a file called short_title.full that
contains a complete error report for the entire book. This is the only error
report that contains information on links and unresolved glossary terms.

About SGML

Each .sgm file contains the SGML version of its associated FrameMaker file. In SGML,
each item is assigned a structural tag, similar to a FrameMaker tag, that describes that
item’s role in the overall document. So, in SGML, as in FrameMaker, an item (such as a
paragraph or a phrase) might be tagged as part of a hanging list, or as a command, or as
a chapter title. A word or phrase can have multiple (nested) labels, as happens with a
command within a hanging list.
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When the conversion tools find something in the FrameMaker file that they don’t know
how to tag, or when they find an item somewhere it’s not supposed to be (such as a
HangingList paragraph tag before the ChapTitle tag), they produce an error message.
The .sgm file in Example 6-1 shows what error messages look like within an SGML file.

Example SGML File

This section contains an example FrameMaker document file and the corresponding
example .sgm file generated by the make book.full command.

FrameMaker Document File

Figure 6-1 shows an example FrameMaker file. This one-page document contains several
paragraph and character tags, including an invalid structure that would generate an
error message during online translation. The invalid structure is a set of square-bulleted
paragraphs within a set of round-bulleted paragraphs; the BulletSquareInd tag should be
used only for sub-steps within a step in a numbered list. (See the annotated chapter
template file, /usr/share/Insight/templates/frame/IPTemplate/samples/IPChap.doc, for more
information on which structures are legal in a document and which aren’t.)
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Figure 6-1 FrameMaker Example Document File
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SGML File

The listing in Example 6-1 represents the .sgm file for the FrameMaker file shown in
Figure 6-1. Look for names of character and paragraph tags to get an idea of how SGML
tags work (“SGML Tag Structure” on page 93 explains the structure of SGML tags in
more detail). Notice the ERROR lines in the middle of the file. This is how error messages
appear within SGML files. The build tools copy all the error messages from each .sgm file
into a corresponding .err file for your convenience.

Example 6-1 SGML Translation of Example FrameMaker File

<!-- Produced by version 3.11 (09/11/95) of SGI Frame/SGML translator
-->
<CHAPTER LBL="1"><TITLE>About the Mottled Oyster</TITLE><PARAGRAPH>The
mottled oyster is an exciting and superfluous new application that
allows you to issue
<!-- ERROR: (4) Unknown Frame tag "Slang" encountered - detected on
page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "CHAR" TAG
= "Slang" TAGCOUNT = "1" UID = "324065" TEXT = "corking"-->
<DUMMY tag="Slang">corking</DUMMY>
commands such as <COMMAND>G&amp;T</COMMAND> (Gin &amp; Tonic; see the
G&amp;T(1) reference page for details). If you read this tutorial
carefully, you're sure to have a <GLOSSARYITEM>jolly good
time</GLOSSARYITEM> with the mottled oyster. After a few hours with
this tutorial you will be able to use the <COMMAND>oyster</COMMAND>
command to do your work more quickly and efficiently. You will
learn</PARAGRAPH>
<BULLETLIST><BULLET><PARAGRAPH>how to prepare your files for bunging
into <COMMAND>oyster</COMMAND></PARAGRAPH>
</BULLET>
<BULLET><PARAGRAPH>general rules to avoid aunts and other
threats</PARAGRAPH>
</BULLET>
<BULLET><PARAGRAPH>the correct intonation for phrases like</PARAGRAPH>
<BULLETLISTIND>
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "1" UID = "324242" TEXT = "&ldquo;tally
ho!&rdquo;"-->
<BULLETSQUAREIND><PARAGRAPH>&ldquo;tally ho!&rdquo;</PARAGRAPH>
</BULLETSQUAREIND>
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<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "2" UID = "324246" TEXT = "&ldquo;hey
what?&rdquo;"-->
<BULLETSQUAREIND><PARAGRAPH>&ldquo;hey what?&rdquo;</PARAGRAPH>
</BULLETSQUAREIND>

<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "3" UID = "324243" TEXT = "&ldquo;old
bean&rdquo;"-->
<BULLETSQUAREIND><PARAGRAPH>&ldquo;old bean&rdquo;</PARAGRAPH>
</BULLETSQUAREIND>
</BULLETLISTIND>
</BULLET>
<BULLET><PARAGRAPH>how to request information from a butler</PARAGRAPH>
</BULLET>
</BULLETLIST>
<PARAGRAPH>To use this tutorial you need a basic understanding of these
items:</PARAGRAPH>
<HANGLIST><HANGPAIR><HANGITEM>cow creamer</HANGITEM>
<HANGBODY><PARAGRAPH>A cow-shaped container holding cream for use in
tea. You should be familiar specifically with the use of the
eighteenth-century English cow creamer.</PARAGRAPH>
<PARAGRAPH>Of course, you must beware of Modern Dutch cow creamers
posing as eighteenth-century English cow creamers.</PARAGRAPH>
</HANGBODY>
</HANGPAIR>
<HANGPAIR><HANGITEM><COMMAND>vi</COMMAND> text editor</HANGITEM>
<HANGBODY><PARAGRAPH>Allows you to edit text using arcane and cryptic
commands.</PARAGRAPH>
</HANGBODY>
</HANGPAIR>
</HANGLIST>
<PARAGRAPH>You might want to look at a copy of the <DOCTITLE>Code of
the Woosters</DOCTITLE> when you're finished with this
tutorial.</PARAGRAPH>
</CHAPTER>
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The usual method of finding such errors is to look at the .err output files after running a
make command. However, you may sometimes need more information about where
exactly in a chapter the error occurs. The simplest approach to finding an error in context
is to use a text editor (such as emacs, vi, or jot) or a pager (such as more or less) to locate all
occurrences within a file of the word ERROR.

SGML Tag Structure

You can see from the example in “SGML File” on page 91 that SGML tags come in pairs.
Each tag pair contains an opening tag and a closing tag, and the opening tag applies to
all of the content between it and the closing tag. Figure 6-2 shows an example of SGML
opening and closing tags with tagged content, in this case simply the word “oyster.”

Figure 6-2 SGML Opening and Closing Tags

Checking the .full File

The short_title.full file provides a complete list of all the errors, warnings, and link
problems in your book. This list consists of three separate kinds of reports: the translation
error and warning report (one for each FrameMaker file), the link QA report file (a single
report for the entire book), and the glossary QA report file (a single report for the entire
book). Each report starts with three equals signs (===) to set it off from the previous
report.

You must fix all the errors listed in the error and warning report and the link QA report.
You should fix the errors listed in the Glossary QA report, but if you don’t fix them your
book will still build.

This section begins with an example .full file, then goes on to explain how to deal with
each of the three types of report files contained in a .full file.

<COMMAND>oyster</COMMAND>

Opening tag Content Closing tag
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An Example .full File

This section contains the .full file corresponding to the example FrameMaker file shown
in Figure 6-1 (for the purposes of this example, assume that the single page of
FrameMaker text is an entire book).

Example 6-2 .full File for a Book

=== oyster.err Translation Error/Warning report ===
<!-- ERROR: (4) Unknown Frame tag "Slang" encountered - detected on
page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "CHAR" TAG
= "Slang" TAGCOUNT = "1" UID = "324065" TEXT = "corking"-->
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "1" UID = "324242" TEXT = "&ldquo;tally
ho!&rdquo;"-->
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "2" UID = "324246" TEXT = "&ldquo;hey
what?&rdquo;"-->
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "3" UID = "324243" TEXT = "&ldquo;old
bean&rdquo;"-->

=== Mottled_Oyster Link QA report file ===
Unresolved References present in this book: None

External Book References present in this book: None

=== Mottled_Oyster Glossary QA report file ===
Unresolved Glossary terms present in this book:
------------------------------------------------
jolly good time
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Translation Error and Warning Report

The translation error and warning report contained in the .full file provides a complete
list of all the translation errors and warnings in your book, grouped by chapter. Before
you hand off your final book to be incorporated into a software build, you must fix all
the translation errors, so that no error messages appear in the translation error and
warning report. You do not need to fix warnings (marked as WARNING instead of ERROR);
you can just ignore those (but you might want to take an especially close look at pages
where warnings occurred when you review the book in IRIS InSight to catch any display
problems).

Here’s the translation error and warning report for the example FrameMaker file shown
in Figure 6-1.

Example 6-3 Translation Error and Warning Report

=== oyster.err Translation Error/Warning report ===
<!-- ERROR: (4) Unknown Frame tag "Slang" encountered - detected on
page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "CHAR" TAG
= "Slang" TAGCOUNT = "1" UID = "324065" TEXT = "corking"-->
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "1" UID = "324242" TEXT = "&ldquo;tally
ho!&rdquo;"-->
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "2" UID = "324246" TEXT = "&ldquo;hey
what?&rdquo;"-->
<!-- ERROR: (16) The Frame tag BulletSquareInd should not occur in a
BULLET - detected on page 1 -->
<!-- ERRORLOCATION: PAGE = "1" SRC = "oyster.mif" TAGTYPE = "PARA" TAG
= "BulletSquareInd" TAGCOUNT = "3" UID = "324243" TEXT = "&ldquo;old
bean&rdquo;"-->

The report includes, for each error, the error message itself (the part that starts with
<!-- ERROR:) and the chunk of SGML that contains the error (the part that starts with
TEXT =). The error message briefly describes the problem and gives a page number for
the page in the FrameMaker file where the error occurred. You can see which file the error
is in because you get a separate error report for each FrameMaker file.
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In this example, the problem is that the writer has tried to use the BulletSquareInd
paragraph tag to create a bulleted list within a bulleted list. This is an illegal structure. To
fix this problem, the writer must open the FrameMaker file and re-tag the offending
paragraphs with the DashInd paragraph tag. Square bullets should only be used to mark
sub-steps within a numbered list; DashInd should be used for sub-bullets within a
round-bulleted list. See /usr/share/Insight/templates/frame/IPTemplate/samples/IPChap.doc
for more information on which structures are legal in a document and which aren’t.

Link QA Report

The link QA report is the second report contained in the .full file. It lists unresolved cross
references and all externally cross-referenced books (it just lists the books, it doesn’t
verify the links.) Here’s the link QA report for the FrameMaker file shown in Figure 6-1:

Example 6-4 Link QA Report

=== Mottled_Oyster Link QA report file ===
Unresolved References present in this book: None

External Book References present in this book: None

In this example, there were no unresolved cross-references or externally cross-referenced
books.

Some unresolved cross references that FrameMaker doesn’t notice are trapped by the
build tools. Usually such undetected cross references are caused by remnants of
incomplete conversions to a new template or from third-party documentation. You can
check for remnant cross references using the FrameMaker search for “Any
Cross-Reference.” The link QA report error indicates the approximate location of
unresolved references. If you have problems finding the unresolved reference, try using
grep to find the MIF files containing the referenced FrameMaker marker ID, then look in
those files after the given marker ID. Sometimes there’s an extraneous FrameMaker
marker containing a cross reference or cross-reference target, and sometimes the link QA
report identifies a nearby marker rather than the marker with the problem.

Glossary QA Report

Unresolved glossary terms are words that are tagged with the “GlossaryItem” character
tag but have no entry in either the local or the global glossary. Example 6-5 is the glossary
QA report for the example FrameMaker file shown in Figure 6-1.
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Example 6-5 Glossary QA Report

=== Mottled_Oyster Glossary QA report file ===
Unresolved Glossary terms present in this book:
------------------------------------------------
jolly good time

Resolve such errors by creating an entry in the glossary or by removing the GlossaryItem
tag from the word in question.

Finding and Fixing Errors

This section discusses error messages that you may encounter while building a book, and
explains how to find and fix the corresponding errors in your FrameMaker files.

Types of Errors

There are three general categories of errors that can occur during the book-build process:

• make book errors (see “make book Error Messages” on page 84 for details)

• MIF-to-SGML translation errors

• unknown errors

Error messages for make book errors appear in the shell window in which you enter the
make command. Error messages for MIF-to-SGML translation errors and unknown errors
appear in files generated during the build process.

Errors are listed in several different files. As explained in “Checking the .full File” on
page 93, all the errors from all the files are listed in the shortname.full file, so that file is a
good place to start looking for errors. However, once you have a general idea of what
errors (and how many) are present in your book, you may prefer to work from a file with
smaller scope, such as the .err file for a particular chapter, and to look in individual .sgm
files to find the context a given error occurred in. “Error Files” on page 88 describes the
different files generated by the conversion tools, and “Choosing a make Command
Argument” on page 78 explains how to use the make command to generate a specific type
of file.
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Finding the Errors in FrameMaker Files

To find a given error, open the FrameMaker file that contains the error, go to the listed
page number, and look for the problem. “MIF-to-SGML Translation Errors” on page 98
lists some common error messages and their causes, so look for your error message in
that list first. If your error message is not in the list, try and find the problem on your own
or call your Silicon Graphics Production Editor for assistance.

Often the problem is easy to spot: an empty anchored frame or a misformatted table, for
example. Sometimes, however, the problem is more difficult to find. “Unknown Errors”
on page 106 lists some tips to help you find more obscure errors.

MIF-to-SGML Translation Errors

This section contains a sample of known error messages with explanations and
suggestions for fixes.

If the translator thinks it knows what the problem is, it provides an error message that
looks something like this:

ch1.sgm: <!-- ERROR: INFORMATIVE, HELPFUL ERROR MESSAGE HERE -->

or

ch4.sgm: <!-- WARNING: STOP YOUR SLACKIN’ -->

This type of error is called a known error, because it comes with an informative error
message. The messages are listed in numerical order, according to the number in
parentheses at the beginning of each message. (The numbers don’t mean anything, and
not all numbers are assigned to a unique error message; don’t worry about gaps in the
numbering, or about repeated numbers.) A few error messages don’t have numbers
assigned; these are listed after all the numbered messages. If your error message isn’t
listed here, follow the instructions in “Unknown Errors” on page 106.

Note that error messages and warning messages generated during MIF-to-SGML
translation have the same basic structure; however, error messages usually indicate that
the book won’t build properly, while you can safely ignore warning messages if you
prefer.
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Problem: Character Tag Spans Hanging List

<!-- ERROR: (1) Character tag tagname spans Hanging List delimiter -->

Character tags shouldn’t be applied to whitespace (such as tabs and hard and soft
returns). This error message indicates that you’ve applied a character tag to both parts of
a hanging list, including the tab that separates them. To fix the problem, apply Default
Paragraph Font to the whitespace between the two parts of the hanging list.

Problem: Maximum Number of Table Footnotes

<!-- ERROR: (2) Maximum number of table footnotes exceeded -->

You can’t have more than 26 footnotes in a single table. Remove some.

Problem: Illegal Structure

<!-- ERROR: (3) Illegal structure starting at ’MIFMarker’ -->

There is a cross-reference marker in the ChapNum paragraph tag at the start of the
chapter being processed. Remove that marker and change any cross-references that
pointed to it so that they point to the chapter’s ChapTitle paragraph instead. You can’t
have a cross-reference to a ChapNum paragraph.

Problem: Unknown Frame Tag

<!-- ERROR: (4) Unknown Frame tag tagname encountered - detected on page
pagenum -->

There is an unrecognized tag in a table. Here are some possible fixes:

• Search for the unrecognized tag in the document file and replace it with a
recognized one.

• If the tag is not found, see if the table uses an unrecognized table format and replace
it with a recognized format.

• If the above two don’t work, look for straddled cells in the table, unstraddle them,
and search on the revealed cells for unrecognized tags.
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Problem: Hanglist Indent

<!-- ERROR: (10) Hanglist indent not under Hanging list -->

This error occurs if a FrameMaker tag (such as CodeInd5) that should occur only directly
after a HangingList or HangingListInd, occurs somewhere else in a document. Don’t try
to use the *Ind paragraph tags to create your own indentation scheme; there are rules
about what indentation can appear where. (The rules are discussed in the sample chapter
file /usr/share/Insight/templates/frame/IPTemplate/samples/IPChap.doc.)

Problem: Hanglist Not Legal

<!-- ERROR: (11) Hanglist not legal in this context -->

The HangingList or HangingListInd tag does not structurally belong in this position in
the FrameMaker file. For example, you can’t legally put a HangingList tag inside a Bullet
list.

Problem: Illegal Help Subtopic

<!-- ERROR: (12) Illegal Help Subtopic content, ‘:’ not found -->

Items tagged with HelpSubTopic should use this syntax:

id_in_frame_file : title_to_appear_at_top_of_card

This error message indicates that the colon in the middle is missing, so the item can’t be
parsed correctly. Add a colon to the HelpSubTopic item.

Problem: No Inline Type

<!-- ERROR: (13) No Inline type specified -->

This message indicates a problem with your specification of an inline media object. The
only allowed types are SGIVIDEO, SGIRGB, SGIAUDIO, and SGIINVENTOR. It’s also
possible that there’s a problem with your syntax: an inline media object should be
specified as type:filename. If you leave out the colon or introduce extraneous spaces or
mistype the type or filename, you may get an error message.
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Problem: Hierarchy Problem

<!-- ERROR: (14) Hierarchy problem for PARAGRAPH -->

Unable to create an SGML <PARAGRAPH> tag for a figure definition. This means the
figure definition (using the Fig paragraph tag) has been applied somewhere it’s not
supposed to be, such as before a ChapTitle. You might also get this message if you use a
Text tag in an unusual position, such as before the ChapTitle. This is a very rare error
message.

Problem: Margin Figure

<!-- ERROR: (15) Margin figure text/graphic flows not in proper order -->

Margin figures are constructed from two anchored frames appearing at the beginning of
a paragraph. The first anchored frame contains a graphic image, and the second (which
is optional) contains a text rectangle with a FigTitleMargin paragraph tag. This error
message indicates that the order of the two anchors has been reversed. Select the
anchored frame for the caption (best to select the frame itself rather than the anchor; it’s
difficult to select a single anchor because the two appear to overlap), remove it using the
Edit > Cut command, place the cursor after the other anchor (you can press the
right-arrow key to move forward over the anchor) and paste the caption back in.

If you get a “margin figure” error about a regular (non-margin) figure, you probably
made a tagging error. If you attach your anchored frame to anything other than an empty
paragraph tagged with the Fig paragraph tag, the figure is treated as a margin figure.

Problem: Frame Tag

<!-- ERROR: (16) The Frame tag tagname2 should not occur in a tagname1 -->

The FrameMaker tag tagname2 cannot legally occur within the structure denoted by
FrameMaker tag tagname1. For example, a DashInd tag does not belong under a
BulletSquareInd tag. Note that sometimes items that look fine from an aesthetic point of
view nonetheless violate the SGML hierarchy and tagging rules set up by Silicon
Graphics’ DTD.
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Problem: Hierarchy Problem

<!-- ERROR: (17) Hierarchy problem for tagname -->

The FrameMaker tag tagname cannot produce the corresponding SGML tag in the
appropriate hierarchical position. The most common cause of this problem is the
placement of the wrong tag at the beginning of a file. For example, a FrameMaker chapter
file must begin with the tag ChapNum, followed by the tag ChapTitle.

Problem: Possible Unused Target

<!-- WARNING: (18) Possible unused Frame Target (target_ID) -->

The indicated FrameMaker target probably doesn’t have anything pointing to it.
Although this is not an error as such, it may indicate an obsolete marker or linking error.
Because this is only a WARNING and not an ERROR, you can safely ignore it if you wish.

Problem: Footnote XREF Targets

<!-- ERROR: (20) Footnote XREF targets (avoid) -->

You can’t make a footnote the target of a cross-reference. Change the cross-reference so
that it doesn’t point to the footnote.

Problem: Footnote INDEX Targets

<!-- ERROR: (21) Footnote INDEX targets (avoid) -->

You can’t index a footnote. Remove the Index marker in the footnote.

Problem: Figure Logic Error

<!-- ERROR: (22) Figure Logic Error -->

This message indicates that you’ve used two anchored frames containing figures before
the figure’s title or caption. This could happen, for instance, if you place two anchored
frames in the same Fig paragraph, before the FigureTitle paragraph. (Note that if one of
the frames is tagged as PrintOnly conditional text, this error shouldn’t occur.)
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Problem: Invalid Marker 18

<!-- ERROR: (23) Invalid Marker 18 format (EXTREF) -->

This message indicates a problem in the syntax for a cross-book link. Make sure that your
link specifies the book you’re linking to, followed by a space, followed by the target
within the book.

Problem: Illegal Tag

<!-- ERROR: (24) Illegal tag in variable tagname -->

You can use character tags in variables, but you can’t use any character tags that you
couldn’t use in ordinary text.

Problem: Tag Is Obsolete

<!-- ERROR: (25) Tag ’tagname’ is obsolete or print-only -->

If your document uses an outdated template, it may contain obsolete tags. Find and
replace all occurrences of such tags using Edit > Find/Change.

Problem: Marker 17

<!-- ERROR: (26) Marker 17 data required for Launchword -->

You can allow IRIS InSight readers to launch an executable by clicking on hot text in your
document. To do this, label your hot text with the Launchword character tag, then place
a FrameMaker Marker of type 17 just before the text. The marker itself must contain text
indicating what to launch, in this format:

Launchword:application_name:command-line_options

This error message indicates that the marker is empty or the syntax is incorrect.

Problem: Index Format Syntax

<!-- ERROR: (27) Index Format Syntax

This message indicates simply that something is wrong with the syntax of an index entry.
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Problem: Msg* Without Preceding Msg*1st

<!-- ERROR: (28) Msg without preceding Msg1st -->

You must use the Msg1st tag before you can use the Msg tag. The same is true for
MsgMargin1st and MsgMargin, and for MsgMarginInd1st and MsgMarginInd.

Problem: MsgExpl Used Without Preceding Msg

<!-- ERROR: (29) MsgExpl used without preceding Msg tag -->

The Msg paragraph tag is part of a construct for displaying error messages that consists
of one or more Msg* paragraph tags followed by one or more MsgExpl paragraph tags.
This error indicates that the MsgExpl tag was used without a preceding Msg tag.

Problem: Index Format Syntax

<!-- ERROR: (30) Index Format Syntax: ’:’ before end tag ’tagname’ -->

This message indicates that you’ve attempted to cross a colon or semicolon boundary,
within an index entry, with a formatting tag.

Problem: Footnote Paragraph Tag

<!-- ERROR: (31) Footnote paragraph tag usage incorrect -->

You can’t legally tag a paragraph in your normal text flow as Footnote or TableFootnote.
If you want a footnote or table footnote in your book, use the FrameMaker Footnote tool
to create it.

Problem: Glossary Tag Usage

<!-- ERROR: (32) Glossary tag usage in this context probably incorrect -->

The GlossaryEntry and GlossaryDef paragraph tags can be used only in a glossary file,
not in any other file in your book. Re-tag the offending paragraphs.
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Problem: Cannot Process Frame

<!-- ERROR: (33) Cannot process Frame on page pagenum -->

This probably means you have an empty anchored frame on page number pagenum.
Import a figure into the anchored frame. See “Working With Figures” on page 50 for
instructions. If a figure isn’t ready yet, you can ignore this error message, view your book
without figures, and put the figures in later. Another possible cause of this error message
is an improperly formatted margin figure.

Problem: Cannot Process Indirect Frame

<!-- ERROR: (34) Cannot process Indirect Frame on page pagenum -->

This indicates that the tools are having a hard time processing a margin figure. When you
add a new margin figure and then build your book, FrameMaker sometimes produces
MIF for the new anchored frames that the translator can’t process. To fix the problem,
save your document file as MIF (using File > Save As...), open the new MIF file, and
resave it as the original .doc file. Note that this procedure resets the autonumbering for
that file; you’ll have to use the Generate/Update command from the book file to make
autonumbering work properly again.

Note: This error does not necessarily indicate that the anchored frames that form the
margin figure are in the wrong order. Margin frames that are properly ordered can still
have this problem.

Problem: Illegal Tag

<!-- ERROR: (34) Illegal tag in index marker: tagname -->

You can use character tags in index markers, but you can’t use any character tags that you
couldn’t use in ordinary text.

Problem: Unclosed Tags

<!-- ERROR: INTERNAL: Unclosed Tags <TextFlow> -->

This error is usually caused by tagging something that should not be tagged or by not
completing a sequence of more than one tag. For example, your file might contain a
hanging list that includes a list item without a body or that is not followed by descriptive
text.
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Problem: Untranslated Function Character

<!--ERROR: Untranslated Function Character (character_name) -->

This message indicates that you’ve used a FrameMaker character that the translation
tools don’t recognize. Search the FrameMaker document for that character—it may be
easiest to find its location by first using grep to search for character_name in the MIF
file—and replace it with a standard character.

Unknown Errors

If the translator gets completely confused, it prints an error message that looks
something like this:

ch2.sgm: <UNKNOWN.ERROR>

This type of error is called an unknown error and seldom provides a helpful error
message. The report lists the page number (for the FrameMaker document) on which the
error occurred.

The translator generates an “unknown error” message when the file conforms to the
DTD (and is therefore structurally legal) but a problem exists anyway. Several different
(but rare) conditions can cause this error. The problem is usually located in the object
immediately proceeding the <UNKNOWN.ERROR> tag; examine the .sgm file to see
exactly where the <UNKNOWN.ERROR> message occurred.

To fix an unknown error, open the FrameMaker file, go to the page number indicated in
the error report, and look for anything that you think might be causing a problem. Here
are some things to look for (in order of likelihood):

• Review the list in Appendix A, “Rules to Follow When Using the Templates.” Make
sure you haven’t violated any of these rules.

• Examine any unusual order of elements. For example, if you put a Figure directly
after an Example—or a TextInd, Example, or Code directly after a Note—you’ll get
an error message.

• Read and follow the guidelines in Chapter 3, “Using FrameMaker Files and
IPTemplate Features.” Problems often arise from errors in figures and in tables.
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7. Testing Online Books

This chapter describes how to install and test an online book and includes the following
sections:

• “Viewing and Testing an Uninstalled Book” on page 107

• “Installing a Localized Book for Testing” on page 109

• “Preparing for Comparative Testing” on page 109

• “Testing an Installed Book” on page 110

See Chapter 8, “Testing Help Books,” for information on installing and testing help
books.

Viewing and Testing an Uninstalled Book

Some localized documents, such as French, German, and Spanish non-help books, can be
opened and tested in IRIS InSight from the workareas in which they have been built.
Japanese non-help books can be opened and tested from a test machine as long as the test
machine has the Japanese environment and kanji fonts installed on it. These books do not
have to be “installed” in order for quality assurance testing to ensue. Other books must
be installed on a test machine running the same operating system for which the books are
intended before quality assurance testing can begin.

Setting Your Environment for Japanese

For Japanese books, your environment must have its LANG set to ja_JP.EUC. To test what
LANG variable is set, enter

% env | grep LANG

To set the LANG variable for Japanese, enter

% setenv LANG ja_JP.EUC



108

Chapter 7: Testing Online Books

Viewing a Book in Your Workarea

Use the following command to display a book with IRIS InSight during the book
development process. This command assumes that your local working directory is the
current directory:

% iiv -b .

In the previous entry, the argument to the iiv command (-b .) directs IRIS InSight to open
the book in the current directory. You can also specify other pathnames (including
relative pathnames) in an iiv command to open books in different directories. However,
any directory that you specify must contain a local books directory that was created by a
successful book build.

For example, the following command opens a book from the user’s home directory:

% iiv -b ~/books/1000/007-1761-010

To view an uninstalled book on a different workstation, use a remote login to the
workstation (% rlogin hostname).

Testing a Book in Your Workarea

Scroll through the online book carefully. Here are a few things to review:

• Do the links work? Do they take you to the right places? If you find a broken
cross-reference, check to make sure it’s correctly formatted in the FrameMaker file
(see “Creating Online Links” on page 44 for instructions).

• Are the Table of Contents, List of Figures, List of Tables, and Index correctly
formatted? If not, try deleting those files and replacing them with the appropriate
template files from the IRIS InSight Professional Publisher template.

• Do all figures appear in the online text? If not, make sure that you set them up
correctly (according to the instructions in “Working With Figures” on page 50). If
figures do appear, do they display correctly?
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Installing a Localized Book for Testing

To install a book on a test machine:

1. Log in to the test machine:

% rlogin name@machine_name

2. Change directories to the workarea where the book files are located:

% cd /.../books/1000/007-1366-100JP

3. Become superuser (root) and install the book using the installtestbooks script:

% su
# set filec
# /path/to/the/script/installtestbooks real

4. If the book is already installed on the test machine, the script will ask you to confirm
information. Type N and press Enter.

PerSysAdmin already exists on the
/usr/share/Insight/library/ja_JP.EUC_bookshelves/SGI_EndUser_Japanes
e bookshelf.
You should use “versions remove” to remove PerSysAdmin to avoid any
potential conflicts.
Do you want to exit now and do a “versions remove” (Y/N)? N

5. At the next prompt, exit the test machine:

# exit

This completes the installation of the localized book.

Preparing for Comparative Testing

Prior to testing the localized book, its English equivalent must be built and installed on
a test machine or be viewable in your workarea.

1. Build the book:

% make book.full

2. Check the .full file to make sure there are no errors or unresolved cross references:

% more *.full
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3. Launch IRIS InSight:

% iiv -f .

The -f argument runs IRIS InSight in the foreground.

4. Click on the book and position its viewer on the left side of your desktop. Set up the
viewer so the Table of Contents is at the top:

Choose Options > Settings... and deselect Side-by-Side View of Books?

5. Log in to the test machine where the localized book has been installed:

% rlogin guest@machine_name

6. Set the environment for the language of the localized book:

Japanese % setenv LANG ja.JP.EUC

French % setenv LANG fr

German % setenv LANG dr

Spanish % setenv LANG es

Note: French, German, and Spanish help books cannot be tested against their
English equivalents from the same test machine.

7. Launch IRIS InSight:

% iiv -f .

8. Click on the book and position its viewer on right side of your desktop (side-by-side
with the English version). Set up the viewer so the Table of Contents is at the top:

Choose Options > Settings... and deselect Side-by-Side View of Books?

Testing an Installed Book

Viewing the installed image shows the final form of the online book as it will appear to
the intended audience. An installed book also allows for a complete quality assurance
test of external book links as well as all the “launchables and linkables” a book may
contain.

Note: Before using this procedure, be sure that your workstation contains the disk space
that the book requires. If you are viewing Help material, follow the instructions in
Chapter 8, “Testing Help Books,” for installation and test procedures.
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Testing Localized Books

Localized books should have the same functionality and overall layout (bulleted lists,
numbered lists, number of paragraphs, and so on) as their English equivalents.

1. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within both books.

2. Test the links from the Table of Contents, List of Figures, List of Tables, and List of
Examples (if applicable). Ensure that the localized version “jumps” to the same
location as the English version.

3. If there are any cross-references, click them in both viewers. Ensure that the
localized version jumps to the same location as the English version.

4. If there are any cross-book links, glossary items, or URLs, click them in both viewers
to ensure they work.

5. Ensure there are the same number of paragraphs, numbered list items, bulleted
items, and so on in the localized book as there are in the English book.

Note: German books tend to have about twenty percent more text than their English
equivalent, although the number of paragraphs should still track with the English
book.

6. If cross-references do not jump to the correct location, or if other active links do not
work as they should, or if anything seems to be missing, make the necessary
corrections in the FrameMaker source and rebuild and reinstall the book.
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8. Testing Help Books

This chapter describes how to test help books and provides a general discussion of how
help works. The mechanism for displaying help is the SGI Help Viewer (also know as
sgihelp).

The following topics are discussed:

• “Overview of Help” on page 113

• “Helpmaps” on page 115

• “Testing Procedures for Online Help” on page 118

Overview of Help

Help generally consists of three parts: the application, the helpmap(s), and the
document. In certain situations, the application can bypass the helpmap and go directly to
the document.

Figure 8-1 shows the flow of how an application accesses its help information.
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Figure 8-1 Standard Flow for Help

Application

Depending on its complexity, an application can include a help menu as well as a help
button (context-sensitive). Widget strings are used to tie the application to its helpmap.

Helpmap

The helpmap is the key to making help work correctly. This text file provides a mapping
between the help menu in the application and the help topics in the online book. Each
helpmap line contains six fields that define the mapping. The third field of the helpmap
corresponds to one of the application’s Help pulldown menu items and to a help topic in
the FrameMaker source used to create the online document.

Help

Help

Application

Helpmap

Document
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Document

The document is the IRIS InSight document being accessed by the helpmap. Any full
section of a document, from one heading to the next heading, can be used as a help topic.
Part of a section of a document, as long as it is a complete SGML structural unit, can also
be used as a help topic.

Helpmaps

A menu item appearing in an application’s pulldown Help menu corresponds to the
third field of a line in the helpmap. The menu item usually matches a heading title in the
FrameMaker source, so the third field of a helpmap usually matches a heading title in the
FrameMaker source. Example 8-1 shows a few lines from an English book’s helpmap.

Example 8-1 A Helpmap Sample

1;Desktop_UG;Overview;0;schemes_overview;Scheme.scheme.overview
2;Desktop_UG;Choosing a Color Scheme;0;schemes_choose;Scheme.scheme
2;Desktop_UG;Editing a Color Scheme;0;schemes_edit;Scheme.scheme
2;Desktop_UG;Deleting a Color Scheme;0;schemes_delete;Scheme.scheme

Localizing Helpmaps

After you build a help book, but before you install it for testing, use the script gethelp to
automatically replace the third field of each line of the helpmap(s) with its localized
equivalents.

Invoke the script at the same level of the book’s directory as the .sgm files.

% gethelp

As described in the section, “gethelp Script” on page 35, this script extracts the help
topics out of the individual SGML files and replaces the third field in the helpmap with
the corresponding string (or heading title). The help directory (containing the helpmaps)
must be present.

The third field is localized automatically by the gethelp script as shown in Example 8-2.
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Example 8-2 A Localized Helpmap Sample

1;Desktop_UG;Présentation du visualisateur de schéma de
couleurs;0;schemes_overview;Scheme.scheme.overview
2;Desktop_UG;Sélectionner un schéma de couleurs;0;schemes_choose;Scheme.scheme
2;Desktop_UG;Modifier un schéma de couleurs;0;schemes_edit;Scheme.scheme
2;Desktop_UG;Supprimer un schéma de couleurs;0;schemes_delete;Scheme.scheme

Checking and Correcting Helpmaps

Do a visual check of all the lines in the localized helpmap. Only the third field of each line
of a helpmap should be localized. Also check for the SGML representations of extended
characters such as umlauts. Figure 8-2 shows an example from the Frame source of a help
topic followed by its heading. Notice the ó in “orientación”.

Figure 8-2 A Help Topic and its Corresponding Heading

When the book is built, the SGML displays this ó character as “&oacute;”. When the
gethelp script is invoked, the localized heading will replace the English equivalent in the
third field of the helpmap, as shown in Example 8-3. Notice that the ó is shown as
“&oacute”.

Example 8-3 A Localized Helpmap Entry

0;Desktop_UG;Cambio de orientaci&oacute;n de los
toolchests;1;window.toolchest;FmPanel.fmPanel

This string of text must be replaced with the actual extended character for the map to
work in SGIHelp. To assist you in this task, Table 8-1 lists most of the extended characters
and their SGML representations.
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Table 8-1 SGML Representations of Extended Characters

Extended Character SGML

þä &auml

ö &ouml

ü &uuml

Å &Auml

Ö &Ouml

Ü &Uuml

á &aacute;

é &eacute;

í &iacute;

ó &oacute;

ú &uacute;

ñ &ntilde;

à &agrave;

è &egrave;

ì &igrave;

ò &ograve;

ù &ugrave;

â &acirc;

ê &ecirc;

î &icirc;

ô &ocirc;

û &ucirc;
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Sometimes the gethelp script does not automatically localize the third field, and in those
cases, you will need to translate it manually. This occurs when Heading-tagged
paragraph is not immediately followed by a Text-tagged paragraph (such as when a
Heading1 is followed by a Heading2).

To perform this translation task, and to correct any extended characters, you may do the
work on a system other than one manufactured by Silicon Graphics. When these
helpmaps are ported back to a system running IRIX, sometimes a foreign character, such
as a “^M”, is introduced to the end of each line in the helpmap. Using more to view the
helpmap does not show these foreign characters; you must use vi or jot to do the visual
QA.

If the foreign characters appear, they must be removed along with any blank space left
by their removal. If a helpmap contains these characters, the help will not work when
called from the application.

Testing Procedures for Online Help

This section discusses the testing procedures for help books.

The first test method, described below, allows you to check the functionality
(cross-references, external book links, and glossary items) within the help book and is
useful when testing your first hand-off. However, it does not provide a means for
checking the help as you would use it from an application. To perform the testing as if
the help was being called from an application, see the following sections:

• “Quick Answers” for 008-2169-nnn on page 122

• “System Monitor Errors Help” for 008-2172-nnn on page 124

• “Desktop Errors Message Help” for 008-2173-nnn on page 127

• “Insight Help” for 008-2174-nnn on page 128

• “SGIHelp Viewer Help” for 008-2181-nnn on page 130

• “Confidence Test Help” for 008-2445-nnn on page 132

• “Confidence Test Errors Help” for 008-3088-nnn on page 135
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The HIDDEN = variable in the Makefile is set to TRUE for help books. Therefore, when
help books are built and installed, they do not appear on the IRIS InSight bookshelves,
nor can they be launched and viewed in your workarea. By changing the HIDDEN =
variable in the built book’s booklist.txt file, the book can be launched and viewed in
IRIS InSight. This method allows you to check the functionality (cross-references,
external book links, and glossary items) within the help book.

Note: This method of testing help books will not work for the help documents System
Monitor Errors and Confidence Test Errors. These two books are simply listings of errors
and their meanings. Because these books are not structured with the required book
elements, there is no way for IRIS InSight to display them in its viewer.

To force a help book to appear in IRIS InSight:

1. Build the book in your workarea:

% make book.full

2. Use a text editor, such as vi or jot, to edit the booklist.txt file:

% vi booklist.txt

3. Change the HIDDEN = variable from TRUE to FALSE.

<BOOK NAME=”ErrorMessageHelp” EDITION=”19941103” ALIAS=”Error
Message Help” TYPE=”generic” HIDE=”FALSE” VERSION=”008-2173-003,
10/94” SORT=”010600” SRCHRES=”TRUE”
SRCHTAGS=”TITLE:Titles;CAPTION,FIGURE:Figure
Captions:1;CAPTION,TABLE:Table Captions:1;TABLE:Tables;CODE
EXAMPLE:Code Examples” GROUP=”SGIDOC”>

4. Save the file.

5. Log in to paranoia (for Japanese books) or gunstar (for European books) and set the
environment:

% rlogin <name>@paranoia
% setenv LANG ja.JP.EUC

6. Change directories to your workarea on midas:

% cd /hosts/midas/online/people/<your_name>/books/1000/007-1366-100JP

7. Launch IRIS InSight:.

% iiv -f -b /hosts/midas/online/people/workarea/<part_number> .

The help book should appear on a Help bookshelf in its localized language.

8. Open and test the book as you would any IRIS InSight book.
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The following sections explain how to test each individual online help document. Each
section is the name of the book followed by its part number, short_title, helpmaps (if any)
for the book, a test script, and an explanation of how to test the helpkeys and the book.
Except for Errors Message Help, each help document has a test script associated with it.
The test script is used to assist you in finding problems. The section on “To test the
book...” for each book describes the preferred method for testing the book. In some cases,
using the script may be the only method available to test a book, and if so, it will be
indicated in the description.

In order to ensure the localized book behaves the same as its English counterpart, follow
these steps:

1. Build and install the English version on a test machine.

2. Open two UNIX shells. Resize and position them at the bottom of your screen, as
shown in Figure 8-3.

3. In the left shell, log in to the test machine where the localized book has been
installed:

% rlogin guest@gunstar

4. Set the environment for the localized book using the BOOK_LANG variable.

Japanese % setenv LANG ja_JP.EUC

French % setenv LANG fr

German % setenv LANG dr

Spanish % setenv LANG es

Note: French and German help books cannot be tested against their English
equivalents from the same test machine.

5. In the right shell, login to the test machine on which the English help book has been
installed.
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6. Follow the test instructions in the specific section for your help book:

• “Quick Answers” on page 122 for 008-2169-nnn

• “System Monitor Errors Help” on page 124 for 008-2172-nnn

• “Desktop Errors Message Help” on page 127 for 008-2173-nnn

• “Insight Help” on page 128 for 008-2174-nnn

• “SGIHelp Viewer Help” on page 130 for 008-2181-nnn

• “Confidence Test Help” on page 132 for 008-2445-nnn

• “Confidence Test Errors Help” on page 135 for 008-3088-nnn

Figure 8-3 Desktop Arrangement for Testing Help Books

The information listed in the following sections explains how to test the localized help
books side-by-side against their same-operating system English counterparts.

Note: Test scripts are slightly different, so look at them closely.
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Quick Answers

Part Number: 008-2169-nnn

ShortTitle: HowDoI_Help

Helpmap(s): Desktophelp.helpmap

Test Script: sgihelp -b DesktopHelp -k helpkey_name

To extract and test helpkeys, perform the following steps:

1. In the UNIX shell for the localized book, enter

% awk -F\; '$2 == “HowDoI_Help” { print $5;}'
< /usr/share/help/BOOK_LANG variable/Desktophelp.helpmap >
~/Desktophelpkeys

This script extracts the information from the fifth field of the helpmap (for those
lines where the second field has this book’s short_title) and creates a file containing
a listing of these helpkeys (these are the same names as HelpTopic-tagged
paragraphs in a book). Because Desktophelp.helpmap contains helpkeys for other
books, this script ensures that only the helpkeys associated with this book are
extracted.

2. Open and display the text file Desktophelpkeys using jot or more. Reduce the size of
the shell and move it to one side of your desktop.

3. Enter the following test script into both UNIX shells using the first helpkey from the
list. Append the script with -f &:

% sgihelp -b HowDoI_Help -k helpkey_name -f &

4. Two SGI Help—Desktophelp viewers should appear, one in English and one in the
localized language.

5. Position the two viewers and shells as shown in Figure 8-3.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. Highlight and paste the first part of the test script into each shell, but use the next
helpkey from the list:

% sgihelp -b HowDoI_Help -k helpkey_name
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8. If the localized viewer does not jump to the same location as the English viewer, or if
a dialog box appears, then there is a problem with the help topic in the Frame
source or with the corresponding line in the helpmap.

9. Repeat the test script for each helpkey in the list.

To test the book, perform the following steps:

1. In both UNIX shells, enter

% /usr/sbin/desktophelp

Two SGI Help—Desktophelp viewers should appear, one in English and one in the
localized language, each with an index listing in the appropriate language.

2. Double-click the first index entry in each viewer. Two new viewers should appear.

3. Position the four viewers as shown in Figure 8-4.

4. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

5. If there are any cross-references, click them in both viewers. Ensure that the
localized version jumps to the same location in the book as the English version.

6. If there are any cross-book links, glossary items, or launchable URLS or
applications, click them in both viewers to ensure that they work.

7. Continue checking each and every index entry to ensure the localized version
behaves the same as the English version.

8. If the localized index entry does not launch a viewer, if cross-references do not jump
to the correct location, or if cross-links or other active links do not work as they
should, make corrections in the FrameMaker source.
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Figure 8-4 Quick Answers Test Setup

System Monitor Errors Help

Part Number: 008-2172-nnn

ShortTitle: ErrorHelp

Helpmap(s): No helpmaps. This uses the helpmaps from SysMonHelp.

Test Script: sgihelp -b ErrorHelp -k helpkey_name

To extract and test helpkeys. perform the following steps:

1. In the UNIX shell for the localized book, enter

% awk -F\; '$2 == "ErrorHelp" { print $5;}'
< /usr/share/help/BOOK_LANG variable/Sysmon.helpmap >
~/SysmonErrorkeys

This extracts the helpkeys associated with only this help book and writes them to a
file named SysmonErrorkeys.

2. Open and display the text file SysmonErrorkeys using jot or more. Reduce the size of
the shell and move it to one side of your desktop.

3. Type the following test script into both UNIX shells using the first helpkey from the
list. Append the script with -f &:

% sgihelp -b ErrorHelp -k helpkey_name -f &
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4. Two ErrorHelp viewers should appear, one in English and one in the localized
language.

5. Position the two viewers and shells as shown in Figure 8-3.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. Highlight and paste the first part of the test script into each shell, but use the next
helpkey from the list:

% sgihelp -b ErrorHelp -k helpkey_name

8. If the localized viewer does not jump to the same location as the English viewer, or if
a dialog box appears, make corrections in the Frame source and rebuild and
reinstall the book.

9. Repeat the test script for each helpkey in the list.

To test the book, perform the following steps:

1. In both UNIX shells, enter

% sysmon

Two System Log viewers should appear, one in English and one in the localized
language, each with an index listing in the appropriate language.

2. Pull down the Filter menu and ensure that all the items have checkmarks next to
them. A series of messages should appear in each viewer.

3. Pull down the Help menu in both viewers and choose Index. Two new viewers
should appear. Close the System Log viewers.

4. Double-click the first index entry having to do with error messages in each viewer.
Two new viewers should appear.

5. Position the four viewers as shown in Figure 8-5.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. If there are any cross-references, click on them in both viewers. Ensure that the
localized version jumps to the same location in the book as the English version.

8. If there are any cross-book links, glossary items, or launchable applications or URLs,
click on them in both viewers to ensure they work.
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9. Continue checking the remaining index entries to ensure that the localized version
behaves the same as the English version.

10. If the localized index entry does not launch a viewer, or if cross-references do not
jump to the correct location or cross-links or other active links do not work as they
should, make corrections in the Frame source.

Figure 8-5 ErrorHelp Test Setup
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Desktop Errors Message Help

Part Number: 008-2173-nnn

ShortTitle: ErrorMessageHelp

Helpmap(s): No helpmaps

Test Script: sgihelp -b ErrorMessageHelp -k HelpTopic from Frame source

To test the book, perform the following steps:

1. Open the English version of the FrameMaker document source, error2.doc.

2. From the Edit menu, choose Find/Change. Set up the dialog box to search for
HelpTopic paragraph tags. Press Find.

3. Enter the following test script into both UNIX shells using the first HelpTopic from
the FrameMaker source. Append the script with -f &:

% sgihelp -b ErrorMessageHelp -k HelpTopic -f &

4. Two SGI Help viewers should appear, one in English and one in the localized
language.

5. Position the two viewers and shells as shown in Figure 8-3.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. If there are any cross-references, click them in both viewers. Ensure that the
localized version jumps to the same location in the book as the English version.

8. If there are any cross-book links, glossary items, or launchable applications or URLs,
click them in both viewers to ensure they work.

9. In the Frame source, find the next HelpTopic.

10. Highlight and paste the first part of the test script into each shell, but use the next
HelpTopic from the Frame source.

% sgihelp -b ErrorMessageHelp -k HelpTopic

11. If the localized viewer does not “jump” to the same location as the English viewer,
or if a dialog box appears, make corrections in the Frame source and rebuild and
reinstall the book.

12. Repeat the test script for each HelpTopic in the FrameMaker source.
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Insight Help

Part Number: 008-2174-nnn

ShortTitle: InsightHelp

Helpmap(s): Insight.helpmap

Test Script: sgihelp -b InsightHelp -k helpkey_name

To extract and test helpkeys, perform the following steps:

1. In the UNIX shell for the localized book, type

% awk -F\; '{ print $5;}' < /usr/share/help/BOOK_LANG
variable/Insight.helpmap > ~/Insightkeys

2. Open and display the text file Insightkeys using jot or more. Reduce the size of the
shell and move it to one side of your desktop.

3. Enter the following test script into both UNIX shells using the first helpkey from the
list. Append the script with -f &:

% sgihelp -b InsightHelp -k helpkey_name -f &

4. Two SGI Help viewers should appear, one in English and one in the localized
language.

5. Position the two viewers and shells as shown in Figure 8-3.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. Highlight and paste the first part of the test script into each shell, but use the next
helpkey from the list.

% sgihelp -b InsightHelp -k helpkey_name

8. If the localized viewer does not jump to the same location as the English viewer, or if
a dialog box appears, make corrections in the Frame source.

9. Repeat the test script for each helpkey in the list.

To test the book, perform the following steps:

1. In both UNIX shells, enter

% /usr/sbin/insight

Two IRIS InSight Library viewers should appear, one in English and one in the
localized language.
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2. Pull down the Help menu in both viewers and choose the first item. Two
IRIS InSight Help viewers should appear.

3. Position the four viewers as shown in Figure 8-6.

4. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within both books.

5. If there are any cross-references, click them in both viewers. Ensure that the
localized version “jumps” to the same location as the English version.

6. If there are any cross-book links, glossary items, or URLs, click them in both viewers
to ensure they work.

7. Continue checking the remaining help entries to ensure the localized version
behaves the same as the English version.

8. Position the cursor over a button in the IRIS InSight Help English viewer and press
the F1 key. Another help viewer should appear with information about that button.
Repeat this for the localized viewer and verify that the same information appears in
the help viewer.

9. Continue checking all the buttons and the menu bar as described in step 8.

10. Pull down the Help menu in both viewers and choose Index. Two new viewers
should appear. Close the IRIS Insight Help viewers.

11. Double-click the first index entry in each viewer. Two new SGI Help viewers should
appear.

12. Position the four viewers as shown in Figure 8-5.

13. Study the layout of the information in each viewer to ensure that the viewers are at
the same location in both books.

14. Continue checking the remaining index entries to ensure that the localized version
behaves the same as the English version.

15. If the localized index entry does not launch a viewer, if cross-references do not jump
to the correct location, or if cross-links or other active links do not work as they
should, make corrections in the Frame source and rebuild and reinstall the book.
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Figure 8-6 IRIS InSight Help Test Setup

SGIHelp Viewer Help

Part Number: 008-2181-nnn

ShortTitle: ViewerHelp

Helpmap(s): SGIHelp.helpmap

Test Script: sgihelp -b ViewerHelp -k helpkey_name

To extract and test helpkeys, perform the following steps:

1. In the UNIX shell for the localized book, enter

% awk -F\; '{ print $5;}' < /usr/share/help/BOOK_LANG
variable/SGIHelp.helpmap > ~/SGIHelpkeys

2. Open and display the text file SGIHelpkeys using jot or more. Reduce the size of the
shell and move it to one side of your desktop.

3. Enter the following test script into both UNIX shells using the first helpkey from the
list. Append the script with -f &:

% sgihelp -b ViewerHelp -k helpkey_name -f &
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4. Two SGI Help viewers should appear, one in English and one in the localized
language.

5. Position the two viewers and shells as shown in Figure 8-7.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. Highlight and paste the first part of the test script into each shell, but use the next
helpkey from the list.

% sgihelp -b ViewerHelp -k helpkey_name

8. If the localized viewer does not jump to the same location as the English viewer, or if
a dialog box appears, make corrections in the FrameMaker source.

9. Repeat the test script for each helpkey in the list.

To test the book, perform the following steps:

1. In both UNIX shells, enter

% sgihelp -b ViewerHelp -k help_overview

Two SGIHelp viewers should appear, one in English and one in the localized
language.

2. Pull down the Help menu in both viewers and choose the first item.

Note: New viewers do not appear; however, the information within each viewer
should change.

3. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within both books.

4. If there are any cross-references, click them in both viewers. Ensure that the
localized version jumps to the same location as the English version.

5. If there are any glossary items or URLs, click them in both viewers to ensure they
work.

6. Continue checking the remaining help entries to ensure that the localized version
behaves the same as the English version.

7. If cross-references do not jump to the correct location or if other active links do not
work as they should, make corrections in the Frame source and rebuild and reinstall
the book.
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Figure 8-7 SGI Help Test Setup

Confidence Test Help

Part Number: 008-2445-nnn

ShortTitle: ConfTestHelp

Helpmaps: Confidence.helpmap
ConfTestHelp.helpmap

Test Script: sgihelp -b ConfTestHelp -k key_name

To extract and test helpkeys, perform the following steps:

1. Extract the helpkeys from the Confidence.helpmap. In the UNIX shell for the
localized book, enter

% awk -F\; '{ print $5;}' < /usr/share/help/BOOK_LANG
variable/Confidence.helpmap > ~/Confidencekeys

To extract the helpkeys from the ConfTestHelp.helpmap, enter

% awk -F\; '$2 == "ConfTestHelp" { print $5;}'
< /usr/share/help/BOOK_LANG variable/ConfTestHelp.helpmap >
~/ConfTestHelpkeys

2. Open and display the text file Confidencekeys using jot or more. Reduce the size of the
shell and move it to one side of your desktop.

Localized
SGIHelp

viewer

Shell for
localized book

English
SGIHelp
viewer

Shell for
English book
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3. Enter the following test script into both UNIX shells using the first helpkey from the
list. Append the script with -f &:

% sgihelp -b ConfTestHelp -k helpkey_name -f &

4. Two SGI Help viewers should appear, one in English and one in the localized
language.

5. Position the two viewers and shells as shown in Figure 8-3.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. Repeat the test script for each helpkey in the list.

8. Open and display the text file ConfTestHelpkeys using jot or more. Reduce the size of
the shell and move it to one side of your desktop.

9. Highlight and paste the first part of the test script into each shell, but use the first
helpkey from the list:

% sgihelp -b ConfTestHelp -k helpkey_name

10. If the localized viewer does not jump to the same location as the English viewer, or if
a dialog box appears, make corrections in the Frame source.

11. Repeat the test script for each helpkey in the list.

To test the book, perform the following steps:

1. In both UNIX shells, enter

% confidence

Two System Log viewers should appear, one in English and one in the localized
language, each with an index listing in the appropriate language.

Note: An informational dialog box may appear. Press the OK button to continue.

2. Pull down the Filter menu and ensure that all the items have checkmarks next to
them. A series of messages should appear in each viewer.

3. Pull down the Help menu in both viewers and choose the item named Overview.
Two SGI Help viewers should appear.

4. Position the four viewers as shown in Figure 8-5.

5. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within both books.
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6. If there are any cross-references, click them in both viewers. Ensure that the
localized version jumps to the same location as the English version.

7. If there are any cross-book links, glossary items, or URLs, click them in both viewers
to ensure that they work.

8. Continue checking the remaining help entries to ensure that the localized version
behaves the same as the English version.

9. If cross-references do not jump to the correct location or if other active links do not
work as they should, make corrections in the Frame source and rebuild and reinstall
the book.

10. Position the cursor over a button in the Confidence Tests English viewer and press
the F1 key. Another help viewer should appear with information about that button.
Repeat this for the localized viewer and verify that the same information appears in
the help viewer.

11. Continue checking all the buttons and the menu bar as described in step 10.

12. Close the SGI Help viewers.

13. Pull down the Help menu in both System Log viewers and choose Index. Two new
viewers should appear.

14. Click on the first index entry in each viewer. Two new SGI Help viewers should
appear.

15. Study the layout of the information in each viewer to ensure that the viewers are at
the same location in both books.

16. Continue checking the remaining index entries to ensure the localized version
behaves the same as the English version.

17. If the localized index entry does not launch a viewer, if cross-references do not jump
to the correct location, or if cross-links or other active links do not work as they
should, make corrections to the FrameMaker source and rebuild and reinstall the
book.
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Confidence Test Errors Help

Part Number: 008-3088-nnn

ShortTitle: ConfTestErrors

Helpmap(s): ConfTestHelp.helpmap

Test Script: sgihelp -b ConfTestErrors -k key_name

To extract and test helpkeys, perform the following steps:

1. Extract the helpkeys from the ConfTestHelp.helpmap. In the UNIX shell for the
localized book, enter

% awk -F\; '$2 == "ConfTestErrors" { print $5;}'
< /usr/share/help/BOOK_LANG variable/ConfTestHelp.helpmap >
~/ConfTestHelpkeys

2. Open and display the text file ConfTestHelpkeys using jot or more. Reduce the size of
the shell and move it to one side of your desktop.

3. Type the following test script into both UNIX shells using the first helpkey from the
list. Append the script with -f &:

% sgihelp -b ConfTestErrors -k helpkey_name -f &

4. Two SGI Help viewers should appear, one in English and one in the localized
language.

5. Position the two viewers and shells as shown in Figure 8-3.

6. Study the layout of the information in each viewer to ensure that the viewers are at
the same location within the English book and the localized book.

7. If the localized viewer does not jump to the same location as the English viewer, or if
a dialog box appears, make corrections in the Frame source and rebuild and
reinstall the book.

8. Repeat the test script for each helpkey in the list.
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9. Preparing Files for Handoff to Silicon Graphics

This chapter describes the naming conventions of the files you prepare for hand-off to
Silicon Graphics as well as what files need to be included with each hand-off. See your
project schedule for the hand-off dates. If you’re unable to make your hand-off date,
please negotiate a new date with your L10N project manager.

Naming Conventions

The files you download from Silicon Graphics should include all the files necessary to
produce an English version of a document. These files include

*.doc FrameMaker source files for the book.

bookfile FrameMaker bookfile.

*.sgm SGML files for the online version of the book.

Makefile Text file with instructions.

orig directory All the original artwork for the book:

• .rgb files are RGB screen captures

• .ai files are Encapsulated PostScript files authored in
Adobe Illustrator.

• .ps files are Encapsulated PostScript files authored in
Adobe Illustrator.

• .mv files are SGI movie format files.

print directory All print versions of the artwork for the book:

• .bw files are the grayscale versions of the .rgb files after they have
been put through the tobw tool.

• .ai files are identical to those in the orig directory.

online directory All .gif files for the online version of the book.
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help directory All the helpmaps necessary for the book to act as online help for an
application or utility.

diff directory All the compare (CMP) and summary (SUM) files documenting the
differences between this version and a previous version of the book.

PostScript Files

If a book project requires PostScript files as a deliverable, create a PostScript file for each
Frame file that makes up a book. All PostScript files should be included in a directory
named psfiles. Place the psfiles directory at the same level as the print and orig directories
in a book directory. See Table 9-1 for the naming conventions to use for the files.

Note: The interactive script getps will create PostScript files from a book’s FrameMaker
bookfile, number them automatically, and place them in a directory named psfiles.
Contact your Production Editor if you would like to use this tool (it is not included in the
prod toolroot).

Table 9-1 PostScript File Naming Conventions

Name Description

##front.ps front is ’Title/Credits’

##TOC.ps TOC is ’Table of Contents’

##LOE.ps LOE is ’List of Examples’

##LOF.ps LOF is ’List of Figures’

##LOT.ps LOT is ’List of Tables’

##intro.ps intro is ’About this Guide’

##ptab#.ps ptab is ’Part Tab’

##tab#.ps tab is ’Chapter Tab’

##chap#.ps chap is ’Chapter’

##appX.ps app is ’Appendix’; X is an uppercase letter

##gloss.ps gloss is ’Glossary’

##IX.ps IX is ’Index’
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Tarring Files

Before you send files to Silicon Graphics, you must prepare them for downloading to an
FTP site.

1. Check files within the directory and ensure that the Makefile is present.

Note: Files for Japanese books must contain the .mif files.

% ls 007-1234-567JP

ch1.doc ch1.mif ch2.doc ch2.mif Makefile

2. Make a tar file containing all files under the 007-1234-567JP directory and name it
YY.MM.DD.007-1234-567JP.tar.

% tar cvf YY.MM.DD.007-1234-567JP.tar 007-1234-567JP

a 007-1234-567JP/ch1.doc 2 blocks

3. Confirm the file was created:

% ls

007-1234-567JP YY.MM.DD.007-1234-567JP.tar

4. Confirm the contents of the tar file:

% tar tvf YY.MM.DD.007-1234-567JP
rwxr-xr-x 11113/10 Feb 21 15:51 1997 007-1234-567JP/
rw-r--r-- 11113/10 972 Feb 18 21:41 1997
1007-1234-567JP/ch1.doc

Compressing Files

1. Compress the tar file:

% gzip YY.MM.DD.007-1234-567JP.tar

2. Confirm the gzipped file:

% ls

007-1234-567JP YY.MM.DD.007-1234-567JP.tar.gz
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First Handoff

Once the linguistic translation of a book is complete, post the FrameMaker or MIF files
to Silicon Graphics’ FTP site and notify L10n and Production that the files are ready for
review. This first hand-off is intended for linguistic review by L10N and a quick
functionality check by Production to ensure that all of the files are present and that the
markers or cross-references have not been removed during the translation process. A
hard-copy printout of the FrameMaker files for European books is supplied to L10N for
their review. Nihon Silicon Graphics (NSG) provides linguistic review and feedback for
Japanese books.

In the first hand-off, include all the *.doc files, *.book file, and, optimally, a Makefile and the
orig, print, and help directories (if applicable) so a test build can be done. For Japanese
books, the *.mif files must also be included.

Second Handoff

In the second hand-off, include all the *.doc, *.sgm, and *.book files, a Makefile, and the
orig, print, online, and help directories (if applicable). For Japanese books, the *.mif files
must also be included.

Final Handoff

Because this is the final hand-off, include all the *.doc, *.sgm, and *.book files, a Makefile,
and the orig, print, online, and help directories (if applicable). For Japanese books, the *.mif
files must also be included. The final hand-off files should result in a buildable, error-free
book with the same functionality as its English equivalent.
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10. Transferring Files Using FTP

Instructions for Downloading Files

This section instructs localization vendors on how to use the FTP utility to download files
from sgiblab.sgi.com.

Note: Use binary mode to transfer files. If files are downloaded in ASCII mode, the
FrameMaker source documents will become corrupted.

You will receive an e-mail message from the Production Editor indicating files are
available for downloading. The message will include the path to the files and the
filenames.

To transfer files from sgiblab.sgi.com:

1. Start an FTP connection to sgiblab.sgi.com.

% rftp sgiblab.sgi.com

2. Enter the username:

Name (sgiblab.sgi.com:username): lpftp

3. Get the lpftp password from your production editor and enter it:

Password: password

lpftp is the present directory.

4. Ensure that you are using binary mode to transfer the files:

ftp> binary (or bin)

5. Change to the receive directory:

ftp> cd receive

6. List the part number directories:

ftp> ls
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7. Change to the appropriate directory:

ftp> cd vendor_name/from.SGI

8. The interactive mode prompts you before transferring each file using mget. To turn
off the interactive mode, enter

ftp> prompt

9. Transfer files.

For multiple files, enter

ftp> mget *.tar

For a single file, enter

ftp> get filename

10. Exit FTP.

ftp> bye

Reply to the e-mail message and indicate that the files were successfully transferred.

Instructions for Uploading Files

This section instructs localization vendors on how to use FTP to copy files to
sgiblab.sgi.com.

To transfer files to sgiblab.sgi.com:

1. Start an FTP connection to sgiblab.sgi.com.

% rftp sgiblab.sgi.com

2. Enter the username:

Name (sgiblab.sgi.com:username): lpftp

3. Get the lpftp password from your production editor and enter it:

Password: password

lpftp is the present directory.

4. Change to the receive directory.

ftp> cd receive
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5. List part number directories.

ftp> ls

6. Change to the appropriate directory.

ftp> cd vendor_name/to.SGI

7. Make a directory using today’s date as the name. For example:

ftp> mkdir 022197

8. Change to the date directory.

ftp> cd today’s_date

9. The interactive mode prompts you before transferring each file using mput. To turn
off the interactive mode, enter

ftp> prompt

10. Transfer files.

For multiple files, enter

ftp> mput *.tar

For a single file, enter

ftp> put filename

11. Exit FTP.

ftp> bye

Send an e-mail message to the Production Editor indicating that the files were
successfully transferred.
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11. Reporting Bugs

During the iterative quality assurance testing process, bugs in either the new English
version of a document or inconsistencies between the user interface (UI) and the
documentation of the UI may become apparent. These bugs, such as broken cross
references and glossary items that do not launch definitions, should be fixed in the
localized version by the vendor. Vendors are encouraged to report bugs they find and can
do so via e-mail.

In order for you to file bugs using e-mail, your login name and domain need to be
registered to PV or BugWorks. This should be done by Silicon Graphics.

Addressing the E-mail

Address the e-mail to sgi.bugs.worldview@relay.engr.sgi.com.

The following items are automatically generated by the bugs database:

• Incident #

• Submitter (this is parsed from sender of the e-mail)

• Opened Date

• Submitter Domain

Subject Field

The Subject field of the e-mail should be a brief summary of the bug and have the format

BUG short description of error
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Message Contents

In order for the bug information to map to the fields of a bug report, type the following
field names as shown and append each with an appropriate entry:

• Priority : [see “Priority Guidelines”]

• Product-Name : part_number

• Project : worldview

• Assign-To : login@domain

• CClist : [see “CClist”]

• Category : documentation

• Command : -jp- or -fr- or -de- or -es-

• Assigned-Group : pubs-enduser or pubs_sysadmin

• Description : [see “Description Guidelines”]

Priority Guidelines

1. Severe error.

2. Major loss of functionality.

3. Miner loss of functionality.

4. Nuisance error.

CClist

The CClist field should include the addresses for the localization manager, production
editor, and any others who may be involved in the project. In order for you to receive a
copy of the bug report, you should include you e-mail address, such as sgibugs@pac.co.jp.
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Description Guidelines

The Description should be detailed and provide enough information for a writer to locate
the bug. The following elements should be included:

1. Book title and part number.

2. Chapter.

3. Heading title.

4. Detailed location of bug.

For example:

Desktop User’s Guide, 007-1342-130
Chapter 6
Finding Large Files
Last paragraph is missing a cross-book link to the “Personal System
Admimistration Guide”.
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A. Rules to Follow When Using the Templates

This list was compiled by writers with online experience at Silicon Graphics. If you break
any rule on this list, you’ll get errors when you try to put your book online. Even if your
book isn’t going online immediately, follow these instructions wherever possible:

• Name all your FrameMaker files so that they end in the suffix .doc (ch1.doc, ch2.doc,
appa.doc, and so on).

• Use the FrameMaker Table menu to create tables.

• Use only paragraph and character tags from the current templates; don’t make up
your own; don’t redefine existing tags.

• Don’t use any of the TextInd paragraph tags to create multi-paragraph Notes,
Cautions, and Warnings. Use two soft returns (Shift + Return) to get a
multi-paragraph look.

• Tag words that appear in the glossary with the character tag GlossaryItem. Do this
once per section, not every time the word appears. If you aren’t creating a glossary
for your book, don’t use the GlossaryItem character tag.

• Don’t begin character tags in the middle of a word.

• Create registration, trademark, and copyright symbols as described in “Create Valid
Copyright and Trademark Symbols” on page 42.

• Begin Front matter files with the Title tag. Begin Chapters with the ChapNum and
ChapTitle tags (in that order). Begin Appendices with the AppNum and ChapTitle tags
(in that order). Begin Introductions or Prefaces with the ChapTitle tag (do not
include ChapNum tag). Begin Glossaries with the GlossaryTitle tag.

• Use the FrameMaker cross-reference formats. These automatically become links
online.

• Don’t put cross-references in AppNum or ChapNum paragraph tags. Put them in
the Chapter title.
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• Import all figures by reference, from a directory named print. The print directory
must be in your book directory (the directory with the Frame files for the book).

• Make sure you use supported formats and processes when creating figures (see
“Working With Figures” on page 50).
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B. Building and Testing HTML Books

This chapter describes how to install and test an HTML book and includes the following
sections:

• “Building an HTML Book” on page 151

• “Installing an HTML Book” on page 154

• “Testing an HTML Book” on page 156

Building an HTML Book

The part number directory of a typical HTML book will contain files such as those shown
in Example B-1.

Example B-1 Directory of a Sample HTML Book

Hints/ Makefile images/ index.html

In this example, the Hints directory contains several .html files and the images directory
contains all the .gif files for the HTML book. The localized version’s book directory
should use the same naming conventions for all its files and directories.

Makefile Parameters

After you have finished translating the text and image callouts for an HTML document,
update the HTML Makefile with the language-specific parameters, as shown in
Table B-1(for European documents) or Table B-2 (for Japanese documents).
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Table B-1 Makefile Parameters for WorldView European HTML Books

Parameter German French Spanish

TITLE short_title
(same as English)

short_title
(same as English)

short_title
(same as English)

FULL TITLE Localized book title Localized book title Localized book title

VERSION XXX-XXXX-XXXDE XXX-XXXX-XXXFR XXX-XXXX-XXXES

BOOKSHELF

help books /usr/share/Insight/library/
de_bookshelves/Help

/usr/share/Insight/library/
fr_bookshelves/Help

/usr/share/Insight/library/
es_bookshelves/Help

end-user books /usr/share/Insight/library/
de_bookshelves/
SGI_EndUser_Deutsch

/usr/share/Insight/library/
fr_bookshelves/
SGI_EndUser_Français

/usr/share/Insight/library/
es_bookshelves/
SGI_EndUser_Spanish

admin books /usr/share/Insight/library/
de_bookshelves/
SGI_Admin_Deutsch

/usr/share/Insight/library/
fr_bookshelves/
SGI_Admin_Français

/usr/share/Insight/library/
es_bookshelves/
SGI_Admin_Spanish

BOOK_ICON

help books generic generic generic

end-user books sgi_end_user sgi_end_user sgi_end_user

admin books sgi_admin sgi_admin sgi_admin

BOOK_LANG de fr es

DTD HTML HTML HTML

DOC_TYPE MANUAL MANUAL MANUAL

SORT_ORDER Precede with “#” Precede with “#” Precede with “#”

HIDDEN

for help books TRUE TRUE TRUE

for all others FALSE FALSE FALSE

BOOK_DIRS Same as English Same as English Same as English

HTML_EXTS Same as English Same as English Same as English
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For European books, insert the following line between the BOOK_LANG and DTD
parameters:

BOOKSUBSYSTEM != echo `echo $(BOOK_LANG) | tr ‘[a-z]’
‘[A-Z]’`_$(BOOKSUBSYSTEM)

Table B-2 Makefile Parameters for WorldView Japanese

Parameter Japanese

TITLE short_title
(same as English)

FULL TITLE English book title followed by “(Japanese)”

VERSION XXX-XXXX-XXXJP

BOOKSHELF

help books /usr/share/Insight/library/ja_JP.EUC_bookshelves/Help

end-user books /usr/share/Insight/library/ja_JP.EUC_bookshelves/SGI_EndUser_Japanese

admin books /usr/share/Insight/library/ja_JP.EUC_bookshelves/SGI_Admin_Japanese

BOOK_ICON

help books generic

end-user books sgi_end_user

admin books sgi_admin

BOOK_LANG ja_JP.EUC

DTD HTML

DOC_TYPE MANUAL

SORT_ORDER Precede with “#”

HIDDEN

for help books TRUE

for all others FALSE

BOOK_DIRS Same as English

HTML_EXTS Same as English
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Making the booklist.txt File

“Building” an HTML document requires only that you create a booklist.txt file.

1. From your HTML book’s directory, enter

% make booklist.txt

2. Use more or vi to view the booklist.txt file.

% more booklist.txt

<BOOK NAME=”Hints_Shortcuts” ALIAS=”Hints and Shortcuts (Japanese)”
TYPE=”Adi3xDocument” SGITYPE=”sgi_enduser” SGIHIDE=”FALSE”
SGIVERSION=”007-3567-001JP, 6/98” SGIBKADDR=”techpubs@sgi.com”
SGISRCHRES=”FALSE” SGISRCHTAGS=”” SGIGROUP=”HTML”>

Installing an HTML Book

Initial Test

Localized HTML documents in French, German, and Spanish can be opened and tested
in Netscape by pointing the browser to the file location of the workarea in which their
directories reside. Japanese HTML documents can be opened and tested as long as the
host machine has the Japanese environment and kanji fonts installed on it.

1. From Netscape, select Options > Document Encoding, or from Netscape Navigator,
select View > Encoding to set the browser’s language encoding.

Choose Western for French, German, or Spanish books.
Choose Japanese (Auto-Detect) for Japanese books.

2. Point the browser to your book by entering the path to your book’s index.html file in
the Netsite dialog box:

file:/path/to/workarea/index.html

3. Test all the links to ensure that they “jump” correctly.

4. Test all the thumbnail images to ensure that a larger image appears where
appropriate.
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Final Test

HTML books do not have to be “installed” in order to complete a quality assurance test,
but it is recommended that their files and booklist.txt file be copied to a test machine
before testing to simulate the behavior of an installed HTML book.

Note: HTML help books do not appear as launchable books in IRIS InSight because the
IRIS InSight Help bookshelf is “hidden.” HTML help books must be tested from the
application’s Help pulldown menu.

1. Log onto your test machine, change to the location where the files would reside if
they were installed (the bookshelf), and become superuser:

% rlogin guest@<test_machine>

% cd /hosts/<machine_name>/usr/share/Insight/library/
<BOOK_LANG>_bookshelves/<BOOKSHELF>/books

% su

For example, the path to use for a Japanese end-user manual would be
/hosts/<machine_name>/usr/share/Insight/library/ja_JP.EUC_bookshelves/
SGI_EndUser_Japanese/books

2. Create a directory using the book’s short_title:

# mkdir <SHORT_TITLE>

3. Copy the .html and booklist.txt file and all directory files into the short title directory:

# cd <SHORT_TITLE>

# rcp /hosts/<machine_name>/path/to/book/directory/<part_number>/*.*
.

# rcp -r
/hosts/<machine_name>/path/to/book/directory/<part_number>/<dir> .

4. Use vi or jot to add this book’s booklist.txt information to the bookshelf’s booklist.txt
file so it will appear on the IRIS InSight bookshelf.

# vi booklist.txt

For example, the booklist.txt file for the HTLM book Hints and Shortcuts looks like
this:

<BOOK NAME=”Hints_Shortcuts” ALIAS=”Hints and Shortcuts”
TYPE=”Adi3xDocument” SGITYPE=”sgi_enduser” SGIHIDE=”FALSE”
SGIVERSION=”007-3567-001, 3/98” SGIBKADDR=”techpubs@sgi.com”
SGISRCHRES=”FALSE” SGISRCHTAGS=”” SGIGROUP=”HTML”>
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Highlight the string of text or copy it. Close the file.

# cd ..

# vi booklist.txt

5. Position the cursor between other book’s booklist.txt information so that the new
book’s title will appear in alphabetical order with respect to other book titles on the
bookshelf. Insert the copied text using the middle mouse key or paste function.

6. Save and close the booklist.txt file.

7. Exit root:

# exit

% rehash

Note: The installtestbooks script will not work with HTML books.

Testing an HTML Book

Before launching a book for test, set the environment to the language of the book you’ll
be testing.

Setting Your Environment for Japanese

For Japanese books, your environment must have its LANG set to ja_JP.EUC. To test what
LANG variable is set, enter

% env | grep LANG

To set the LANG variable for Japanese, enter

% setenv LANG ja_JP.EUC

Setting Your Environment for European Languages

For German, French, or Spanish books, your environment must have its LANG set to the
appropriate language. To test what LANG variable is set, enter

% env | grep LANG
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To set the LANG variable for German, enter

% setenv LANG de

To set the LANG variable for French, enter

% setenv LANG fr

To set the LANG variable for Spanish, enter

% setenv LANG es

Testing Instructions

To test the localized HTML book:

1. Launch IRIS InSight on the test machine on which the book is installed:

% iiv -f

2. Select the bookshelf on which the book is installed.

3. Double-click the book icon. The book should appear in a Netscape browser.

4. From a machine on which the English version is installed, launch IRIS InSight:

% iiv -f

5. Select the bookshelf on which the English book is installed.

6. Double-click the English book’s icon. The book should appear in a Netscape
browser.

7. Place the two browsers side by side and begin comparative testing.

8. Click on all the links to ensure that the localized version behaves the same as the
English version.

9. Ensure that all the images in the localized version match those in the English
version.

10. Click on all thumbnail images to ensure that they launch enlarged versions of the
images.
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Adobe Illustrator images, 51
.ai files, 51
applications, launching from InSight, 45, 103

B

BOOK_DIRS parameter, 152, 153
BOOK_ICON parameter, 73, 74, 152, 153
BOOK_LANG parameter, 73, 74, 120, 152, 153
book-building

debugging, 87-108
bookbuilding tools, 5
bookfile, 137
booklist.txt file, 119
books

checking, 108
books directory, 77
BOOKSHELF parameter, 72, 74, 152, 153
BOOKSUBSYSTEM parameter, 73, 153
bugs

cc list, 146
description guidelines, 147
e-mail message, 146
e-mail subject, 145
priority guidelines, 146

building
a localized book, 82
European books, 82

HTLM books, 151
.bw files, 51
BW variable, 53

C

chapters
linking to, 99

characters
formatting, 40
invalid, 106
non-alphanumeric, entering, 42

character tags
GlossaryItem, 48
index, 105
using, 40, 41
whitespace, 99

checking helpmaps, 115
code formatting, 41
comparative testing, 109, 111, 123, 125, 127, 128, 129,

131, 133, 135
compressing files, 139
confidence, 133
Confidence.helpmap, 132
Confidencekeys, 132
Confidence Test Errors, 119, 121, 135
Confidence Test Help, 121, 132
ConfTestErrors, 135
ConfTestHelp, 132
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ConfTestHelp.helpmap, 132, 135
ConfTestHelpkeys, 133
copyright symbol, 42
creating PostScript files, 138

D

dashes, 42
desktophelp, 123
Desktophelp.helpmap, 122
Desktophelpkeys, 122
dictionary, 5
diff directory, 138
diff files, 2
directories

figures, 52
online, 50, 52
orig, 50, 52
print, 54

display problems, checking for, 108
DOC_TYPE parameter, 73, 74, 152, 153
.doc files, 137
DTD, 101
DTD parameter, 73, 74, 152, 153

E

em dashes, 42
en dashes, 42
environment

French, 110, 120
German, 110, 120
Japanese, 110, 119, 120
Spanish, 110, 120

environment variables
workarea, 31

equations, online, 41
.err files, 77, 88
error files, 77
Errorhelp, 124
ErrorHelp test setup, 126
ErrorMessageHelp, 127
error messages

make, 84
error report

.full file, 77
errors, 82, 83, 109

cannot process frame, 105
cross references, 96
display problems, 108
example, 89-93
figures, missing, 108
files, 88
fixing, 97-106
formatting, 108
hierarchy problem, 102
links, broken, 108
location of, 98
margin figures, 105
messages, 88
reports, 88, 93-97
translation, 98
types of, 97
unclosed tags, 105
unknown, 106
untranslated function character, 106

Errors Message Help, 120, 121, 127
European language books, 107, 110, 119, 120, 154
extensions, filename, 51
extracting helpkeys, 122, 124, 128, 130, 132, 135

F

figures



161

Index

composite, 50
creating, 50-57
directories, 52
guidelines, 56
links, creating, 45
Makefile editing, 52-53
margin, 101
missing, 105, 108
naming, 51
placement, 101
structure, 102

files
compressing, 139
error files, 88
naming, 51, 137
PostScript, 138
SGML, 88, 137

final vendor handoff, 140
first vendor hand-off, 2, 118
first vendor handoff, 140
Footnote paragraph tag, 104
footnotes

creating, 43
index, 102
links, 102
tables, 49, 99

foreign characters, 118
formats

characters, 40
frontmatter, 108
images, 50
index, 104

FrameMaker
character designer, 40
equations, 41
index markers, 48
line art, 51
link targets, 102
naming files, 149

Smart Spaces, 42
tables, creating, 49
tags, using, 40-43

frames
multiple, 102
processing, 105

frontmatter
formats, 108

ftp, 139
FULL_TITLE parameter, 72, 74, 152, 153
.full file, 77, 88, 93
functionality testing, 111, 118

G

gethelp, 115
getps, 138
.gif files, 51
GIF image format, 51
GIF variable, 53
glossary

links, creating, 45, 48
QA report, 93, 96

GlossaryDef paragraph tag, 104
GlossaryEntry paragraph tag, 104
guidelines for figures, 56
gzip, 139

H

hanging lists, 100
hard returns, tagging, 41
help books

testing procedures, 118
help directory, 138
helpkey, 120, 122, 124, 132, 135
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helpmaps, 113, 114, 115
mapping, 114
widget strings, 114

help overview, 113
HelpSubTopic paragraph tag, 100
help topics, 115, 127
HIDDEN parameter, 73, 74, 119, 152, 153
hierarchy problem, 101, 102
How Do I? Help, 121, 122
HowDoI_Help test setup, 124
HTML_EXTS parameter, 152, 153
HTML books, 151

building, 151
installing, 154
testing, 156

HTML testing instructions, 157

I

Illustrator images, 51
images

formats
filename extensions, 51
supported, 50

importing, 54
original, 50, 52

indentation, 100
Index, 49
index

footnotes, 102
formatting, 104
links, 48
links, creating, 45
syntax, 103
tagging, 105

inline media, 45, 100
Insight Help, 121, 128

InsightHelp, 128
Insight.helpmap, 128
Insightkeys, 128
InSight viewer

checking books, 108
launching applications, 45
links, 45
Table of Contents view, 45

installing HTML books, 154
installtestbooks, 109
IRIS InSight Help test setup, 130
IRIS InSight viewer setup, 110

J

Japanese books, 82, 107, 119, 154
jot, 118, 119, 122, 128, 130, 132, 133, 135

L

launching IRIS InSight, 110, 119, 128
line art, 51
links

automatic, 45
broken, 108
creating, 44-49
cross-book

creating, 60, 61
errors, 103

footnotes, 102
glossary, 48
index, 48
QA report, 93, 96
structural, 45
targets, unused, 102
to another book, 60
to chapters, 99
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within a book, 47
lists, hanging, 100
Localization’s kit, 5

M

make
error messages, 84
generated files/directories, 75
if make doesn’t work, 83

make commands, 77
Makefile, 137

adding image files, 52
figures, 52-53
getting and editing, 72
image files in, 50

Makefile parameters, 119, 151
European, 72, 152
Japanese, 74, 153

margin figures
errors, 101
processing, 105

media, inline, 45, 100
more, 118, 122, 124, 128, 130, 132, 133, 135
Msg* paragraph tags, 104

N

naming conventions
figures, 51
PostScript files, 138

naming Frame files, 149
non-alphanumeric characters, 42

O

online
images, 50

online build process, 71
overview, 71

online directory, 50, 52, 137
orig directory, 50, 52, 137
overview of help, 113

P

paragraph tags
Footnote, 49, 104
GlossaryDef, 104
GlossaryEntry, 104
HelpSubTopic, 100
indentation, 100
Msg*, 104
TableFootnote, 49, 104

parameters
BOOK_DIRS, 152, 153
BOOK_ICON, 73, 74, 152, 153
BOOK_LANG, 73, 74, 120, 152, 153
BOOKSHELF, 72, 74, 152, 153
DOC_TYPE, 73, 74, 152, 153
DTD, 73, 74, 152, 153
FULL_TITLE, 72, 74, 152, 153
HIDDEN, 73, 74, 119, 152, 153
HTML_EXTS, 152, 153
SORT_ORDER, 73, 74, 152, 153
TITLE, 72, 74, 152, 153
VERSION, 72, 74, 152, 153

PostScript
images, 51
variable, 53

PostScript files, 138
preparing

comparative testing, 109
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PRINT_BW variable, 52
PRINT_COLOR variable, 53
print directory, 54, 137
Production’s kit, 5
project schedule, 2
.ps files, 51

Q

QA reports, 93, 96
quality assurance testing, 3
quick reference list, 149
quotation marks, smart, 42

R

reference list, 149
reference pages, links to, 45
registered trademark symbol, 42
returns, soft, tagging, 41
.rgb files, 51
RGB image format, 51
ROOT environment variable, 31
rules for online, 149

S

screen captures, 41
equations, 41

scripts
ConfTestErrors, 135
ConfTestHelp, 132
Desktophelp, 122
ErrorHelp, 124
ErrorMessageHelp, 127

gethelp, 115
InsightHelp, 128
installtestbooks, 109
ViewerHelp, 130

second vendor hand-off, 3
second vendor handoff, 140
.set_workarea file, 31
setting the environment, 110, 119, 120
setting your environment

European, 156
Japanese, 156

SGI_QA environment variable, 31
SGIDOC DTD, 101
sgihelp, 113
SGIHelp.helpmap, 130
SGIHelpkeys, 130
SGI Help test setup, 132
SGI Help Viewer, 113
SGIHelp Viewer Help, 121, 130
SGML

description, 88
files, 88
structure, 40, 89, 101
tags, 88
tag structure, 93

short_title.full file, 88
single files, building, 78
Smart Quotes, 42
Smart Spaces, 42
snapshot tool, 41
soft returns, tagging, 41
SORT_ORDER parameter, 73, 74, 152, 153
spaces in code, 41
structural links, 45
style guide, 5
superuser, 109
symbols
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copyright, 42
invalid, 106
non-alphanumeric, entering, 42
trademark, 42

sysmon, 125
SysmonErrorkeys, 124
System Log, 125, 133, 134
System Monitor Errors, 119, 121, 124

T

TableFootnote paragraph tag, 104
tables

creating, 49
footnotes, 43, 99
links, creating, 45
tags, unknown, 99

tabs
in code, 41

tags
creating, 40
obsolete, 103
placement, 102
sequences, valid, 40
SGML, 93
tips, 40-43
unclosed, 105
variables, 103

tar, 139
targets, unused, 102
templates

annotated, 89
structure, 40
tags, using, 40-43

testing
help books, 121
HTML books, 156
links, 111

TITLE parameter, 72, 74, 152, 153
TOOLROOT environment variable, 31
trademark symbol, 42
translation errors, 95, 98
troubleshooting

book-building, 87-108
displaying, 108
glossary links, 48

U

unclosed tags, 105
unknown errors, 106

V

variables
workarea, 31

variables, character tags, 103
vendor kit, 2
VERSION parameter, 72, 74, 152, 153
vi, 118, 119, 124
Viewerhelp, 130

W

whitespace
character tags, 99

widget strings, 114
workarea

environment variables, 31
.set_workarea file, 31
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.xwd files, 51
XWD image format, 51
XWD variable, 53
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